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INTRODUCTORY SECTION

Threat Analysis Reporter

As perimeter security becomes more mature, user-gener-
ated Web threats increase and become critical aspects of
maintaining networks. Network administrators need tools to
monitor these threats so management can enforce corpo-
rate Internet usage policies.

8e6's Threat Analysis Reporter (TAR) appliance is designed
to offer administrators or management dynamic, real time
graphical snapshots of their network’s Internet traffic,
supported by remediation tools to manage and control user-
generated Web threats. Working in conjunction with 8e6’s
R3000 Enterprise Filter, TAR interprets end user Internet
activity from the R3000’s logs and provides data that can be
viewed via an easy-to-read dashboard of gauges that the
administrator can drill down into to get to the source of the
threat.
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About this User Guide

The Threat Analysis Reporter User Guide addresses the
network administrator designated to configure and manage
the TAR server on the network (referred to as the “global
administrator” throughout this user guide, since he/she has
all rights and permissions on the TAR server), as well as
administrators designated to manage user groups on the
network (referred to as “group administrators” throughout
this user guide).

This user guide is organized into the following sections:

Introductory Section - This section provides general
information on how to use this user guide to help you
configure the TAR server.

Preliminary Setup Section - This section includes infor-
mation on creating and maintaining user accounts.

Configuration Section - This section includes informa-
tion on configuring TAR to alert you of any end user
Internet activity not within your organization’s Internet
usage policies.

Bandwidth Management Section - This section
includes information on monitoring and managing
inbound and outbound traffic on your network.

Administration Section - This section includes func-
tions for maintaining the TAR server or its database.

Technical Support / Product Warranties Section -
This section contains information on technical support
and product warranties

Appendices - Appendix A explains how to disable pop-
up blocking software installed on a workstation in order to
use TAR. Appendix B provides details on setting up and
using the System Tray feature for TAR alerts. Appendix C
features a glossary of technical terminology used in this
user guide.
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* Index - This section includes an index of subjects and
the first page numbers where they appear in this user
guide.

How to Use this User Guide

Conventions

The following icons are used throughout this user guide:

NOTE: The “note” icon is followed by italicized text providing
additional information about the current subject.

TIP: The “tip” icon is followed by italicized text giving you hints on
how to execute a task more efficiently.

& WARNING: The “warning” icon is followed by italicized text
cautioning you about making entries in the application, executing
certain processes or procedures, or the outcome of specified
actions.
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Terminology

The following terms are used throughout this user guide.
Sample images (not to scale) are included for each item.

button - an object in a dialog box, add
window, or screen that can be clicked
with your mouse to execute a command.

checkbox - a small square in a dialog
box, window, or screen used for indi-
cating whether or not you wish to select an option. This
object allows you to toggle between two choices. By
clicking in this box, a check mark or an “X” is placed, indi-
cating that you selected the option. When this box is not
checked, the option is not selected.

Vilser Groups

dialog bOX = a bOX that Delete User Group x
opens in response to @ accounting
command made in a ArE yOU sUFe you want to delete this group? Al

group associations will be erased.

window or screen, and
requires your input. You
must choose an option by
clicking a button (such as
“Yes” or “No”, or “Next” or “Cancel”) to execute your
command. As dictated by this box, you also might need
to make one or more entries or selections prior to clicking
a button.

Back Delete Group

field - an area

in a dialog box,
window, or screen that either accommodates your data
entry, or displays pertinent information. A text box is a

type of field.

Group Name: Administration
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» frame - a boxed-in areain a dialog ===

Employes Name: Comments:

box, window, or screen that oy

includes a group of objects such as o _
fields, text boxes, list boxes, o
buttons, radio buttons, check- S
boxes, and/or tables. Objects

within a frame belong to a specific e :
function or group. A frame often is
labeled to indicate its function or purpose.

* list box - an area in a dialog box, I
window, or screen that accommo- Admin
dates and/or displays entries of Engineering

items that can be added or removed. | =™ <o

e pop-up box or pop-up | Gerpirr =
window - a box or window s
that opens after you click @ S
button in a dialog box, Belete a 6raum
window, or screen. This box
or window may display
information, or may require
you to make one or more
entries. Unlike a dialog box,
you do not need to choose between options.

Query

¢ pull-down menu - a field
in a dialog box, window, or
screen that contains a
down arrow to the right. When you click the arrow, a
menu of items displays from which you make a selection.

admin *
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screen - a main s - |
object of an appli- 5 -
cation that G/ o) Con) ) o
displays across

your monitor. A

screen can .
contain panels, |
windows, frames,
fields, tables, text boxes, list boxes, icons, buttons, and
radio buttons.

tab - one of at least two 1 TP T RT
related pages, each individ- ‘" D e To]n
ually labeled and contained  peswers e
within the same window, Contim Pasewore; Dot

LOGO

but only displaying its page
in the window when
accessed.

Required Next

text box - an area in a dialog box, window, or screen that
accommodates your data entry. A text box is a type of
field. (See “field”.)

window - displays on a screen,
and can contain frames, fields, e

text boxes, list boxes, icons,
buttons, and radio buttons.

Types of windows include ones e
from the system such as the —
Save As window, pop-up
windows, or login windows.
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Environment Requirements

Workstation Requirements

Minimum system requirements for the administrator include
the following:

»  Windows 98 or later operating system (not compatible
with Windows server 2003)

* Internet Explorer (IE) 5.5 or later, or Firefox 1.5 or later
* Flash plug-in version 8 or later

+ Screen resolution set at 1024 x 768 with color quality set
at 16 bits

+ 256MB RAM
* Pentium Il 600 MHz or higher, or equivalent

* Network card and ability to connect to the TAR server
and R3000 server

» Email client that can be set up to receive email alerts
» JavaScript enabled
» Java Virtual Machine

» Java Plug-in (use the version specified for the TAR soft-
ware version)
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Network Requirements

* High speed connection from the TAR server to client
workstations

 FTP or HTTPS connection to 8e6’s patch server

* Internet connectivity for downloading Java virtual
machine/Flash, if not already installed

Installation Prerequisite

* 8e6 R3000 running software version 1.10.15 or later

8 8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE
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Getting Started

Initial Setup

To initially set up your TAR server, the administrator
installing the unit should follow the instructions in the Quick
Start Guide, the booklet packaged with your TAR unit. This
guide explains how to perform the initial configuration of the
server so that it can be accessed via an IP address on your
network.

[‘% NOTE: If you do not have the Threat Analysis Reporter Quick
Start Guide, contact 8e6 Technologies immediately to have a copy
sent to you.

Once the TAR unit is set up on the network, the designated
global administrator of the TAR server should be able to
access the unit via its URL, using the username and pass-
word registered during Step 1 of the quick start wizard
procedures.
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Login window

1. From your workstation, launch Internet Explorer to open
an |E browser window.

NOTE: If pop-up blocking software is installed on the workstation,
it must be disabled. Information about disabling pop-up blocking
software can be found in Appendix A: Disable Pop-up Blocking
Software.

2. In the Address field of the browser window, type in the
URL for the TAR server (in which ‘x.x.x.x’ represents the
IP address specified during quick start procedures):
http://x.x.x.x:8080

This action opens the TAR login window:

Admin Name

|

Password

Fig. 1:1-1 TAR Login window
This window serves as a portal for administrators to log
into TAR.

NOTE: In this window, TAR'’s software version number displays
beneath the frame.

TIP: In any box or window in the application, press the Tab key on
your keyboard to move to the next field. To return to a previous
field, press Shift-Tab.

10 8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE
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Login

To log in the application:

1. In the Username field, type in your username. If you are
logging in as the global administrator, enter the user-
name registered during the quick start wizard proce-
dures. If you are logging in as a group administrator,
enter the username set up for you by the global adminis-
trator.

2. In the Password field, type in your password. If you are
logging in as the global administrator, enter the password
registered during the quick start wizard procedures. If
you are logging in as a group administrator, enter the
password set up for you by the global administrator. This
entry displays as a series of asterisks for security
purposes.

3. Click the Log In button to open the application that
displays the URL dashboard gauge view in the right
panel by default. The navigational panel displays to the
left, and in the panel above the system time and date
display (in the HH:MM:SS/MM.DD.YYYY format) beside
the Logout button:

P A i e m—

i A - : .

Fig. 1:1-2 Default TAR window
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12

Navigational panel menu topics

The navigational panel at the left of the screen consists of
the following menu topics for configuring and using the
application:

URL Dashboard - click this topic to access menu options
for managing URL gauges that monitor Internet activities
which threaten network security, bandwidth usage, and/
or end user productivity.

Administration - click this topic to access menu options
for setting up and maintaining administrator profiles, and
managing the TAR unit.

Policy - click this topic to access menu options for setting
up and maintaining policies used for triggering warnings
when gauges approach their upper threshold limits.

Report/Analysis - click this topic to access menu
options for analyzing Internet usage data.

Bandwidth - click this topic to access menu options for
managing bandwidth for protocols used on the network.

Log out

To log out of the application, click the Logout button in the
upper right corner of the screen. When your session has
been terminated, the login window re-displays.

Exit the interface

To exit the interface, click the “X” in the upper right corner of
the browser window.
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Navigation Tips and Conventions

The following tips and list of conventions will help you navi-
gate the Administrator console:

Move a pop-up window - Click the toolbar of a pop-up
window and simultaneously move your mouse to relo-
cate the pop-up window to another area in the current
browser window.

Close all pop-up windows to access another topic -
In order to access another topic from the navigational
panel at the left of the screen, all open pop-up windows
must first be closed by clicking the “X” in the upper right
corner of each window.

Scroll up and down, and

N ; FFarmer
across a list - If avgllable, use GArmstrong
the scrollbar to the right or along | yicounders
the bottom of a frame or list box | 1y.045

to view an entire list.

Zlamieson
An extensive list can be viewed @

in its entirety by clicking the

back-to-back left and right arrow buttons (circled in the
image above) in order to navigate to the previous or next
section of the list.

Tab to the next field - Press the Tab key on your
keyboard to advance to the next field in a window.

Expand, contract

a column - P ( ¢1|DTW) | Severity |
Columns can be 202.208.20.7 Cockout Low
expanded or : Lockout | Wedium |
contracted by first

mousing over the divider in the column header to display
the arrow and double line characters (<-lI->). A column is

then expanded or contracted by left-clicking the mouse
and dragging the column bar to the right or left.

8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE

13



INTRODUCTORY SECTION NAVIGATION TIPS AND CONVENTIONS

* Browser Back button, Refresh button - Clicking either
the Back button or the Refresh button in your browser will
refresh the TAR interface and log you out of the applica-
tion.
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PRELIMINARY SETUP SECTION

Introduction

The Preliminary Setup Section of this manual is comprised
of three chapters with information on the first steps to take in
order to use the TAR application. These steps include
setting up user groups, administrator permission groups,
and group administrator profiles:

» Chapter 1: User Groups Setup - This chapter explains
how to set up user groups—whose Internet activity will
be monitored by group administrators.

* Chapter 2: Admin Groups Setup - This chapter explains
how to set up permissions so that an administrator in
your group will only be able to access areas of the TAR
console that you specify.

* Chapter 3: Admins Setup - This chapter explains how to
set up a group administrator account.
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Chapter 1: User Groups Setup

On a new TAR server, the global administrator should first
set up user groups—whose Internet activity will be moni-
tored by group administrators.

A group administrator should set up user groups once he/
she is given an account by the global administrator with
permissions to access User Groups, as detailed in the next
chapters in this section.

1. In the navigational panel, click Administration to open
that menu:

— = = =
il A A A A

Fig. 2:1-1 User Groups menu topic
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2. Click User Groups to open the User Groups Manage-
ment pop-up window:
User Groups Management x
User Groups Members

All
Adrnin

Engineering
Quality Cantrol

)
Addd Edit Dielete

Fig. 2:1-2 User Groups Management

If any user groups were previously added by the admin-
istrator, these display in the User Groups list box. For the
global administrator, “All” displays in the User Groups list
box by default.

3. From this pop-up window, you can add a user group, and
modify or delete an existing user group, as necessary. Or
click the “X” in the upper right corner of the pop-up
window to close it.

TIP: To view members that belong to a user group, click the user

group name to highlight it and to display its members in the
Members list box.

NOTES: If using the LDAP user authentication method, user-
names display in pertinent list boxes. If using IP groups, IP
addresses of user machines display instead of usernames.

For LDAP authentication, the member “IPGROUP” pertains to
any end user who has been authenticated but does not yet have
a username associated with his/her IP address.
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Create a User Group

1. Click Add to open the Create a New User Group pop-up
window:

Create a New User Group x

Available Group Members
Administrator

Adrden

ABest

ARandall

BFlores dd

Bharks
BSnetsinger
BThomas
CJdohnson

Chills

DAbrams &

4

Remove

Group Name: Accounting

Submit

Fig. 2:1-3 Create a New User Group

2. Type in the Group Name.

3. From the Available list box, select a member to be added
to the group, and then click Add to move that member to
the Group Members list box.

TIP: To remove a group member, select that member from the
Group Members list box, and then click Remove to move the
member back to the Available list box.

4. Once all members are added to the Group Members list
box, click Submit to close the Create a New User Group
pop-up window, and to include your entry in the User
Groups list box in the User Groups Management pop-up
window.

NOTES: Any user group created as the initial “base group”
cannot be edited, delegated, or deleted.

Once a user group is assigned to a group administrator (see
Chapter 3: Admins Setup), that user group cannot be assigned to
anyone else. To assign the same set of end users to another
group administrator, mirrored user groups should be created.
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Edit a User Group

Once a user group has been created, its name can be modi-
fied, or members can be added to—or removed from—the
group, if it is not the “base group.”

1. In the User Groups Management pop-up window, go to
the User Groups list box and select a user group. This
action highlights the user group name and displays its
members in the Members list box, and also activates the
Edit and Delete buttons:

User Groups Management x
User Groups Members
all FFarmer
Accounting GAmstrong
Admin MSaunders
Engineering TWoods
Quality Control Zlamieson
4
Add Edit Delete

Fig. 2:1-4 User Groups Management, selection

2. Click Edit to open the Edit a User Group pop-up window:

Edit a User Group x
Available Group Members
Administrator A FFarmer
Adrden GArmstrong
ABest MSaunders
ARandall Toods
BFlores Add Zlamieson
BMarks
BSnetsinger —

BThomas

CGlohnsan

CMills

DAbrams 3
r

Group Name:  Accounting

Submit

Fig. 2:1-5 Edit a User Group
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Perform any of the following actions:

* Modify the Group Name
* Add Group Members

* Remove Group Members

. Click Submit to close the Edit a User Group pop-up
window and return to the User Groups Management pop-

up window.

Delete a User Group

To remove a user group (that is not the “base group”) from
the list of available user groups:

1. In the User Groups Management pop-up window, go to

the User Groups list box and select the user group. This
action highlights the user group name and displays its
members in the Members list box (see Fig. 2:1-4).

Click Delete to open the Delete User Group dialog box:

Delete User Group ®
Accounting

Are you sure you want to delete this group? All
group associations will be erased

Cancel Delete Group

Fig. 2:1-6 Delete User Group

Click Delete Group to remove the user group. This
action closes the dialog box and returns you to the User
Groups Management pop-up window.

NOTE: Clicking Cancel closes the dialog box without removing
the user group, and returns you to the User Groups Management
pop-up window.

20
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Chapter 2: Admin Groups Setup

Once you have set up user groups, you are ready to create
a set of management permissions, so that a group adminis-
trator you set up will only be able to access areas of the TAR
console that you specify.

This function is available to a group administrator only if
permissions were granted by the administrator who set up
his/her account, as detailed in this chapter and in Chapter 3.

In the navigational panel, click Admin Groups to open the
Group Management pop-up window:

Group Management x

Groups
Bandwidth Gauges Add a Group

Edit a Group

Delete a Group

Wiew Permissions

Fig. 2:2-1 Group Management

Groups previously set up display in the list box.

From this pop-up window, you can add an administrator
group, view information for an existing administrator group,
and modify or delete that group, as necessary.
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Add a Group
1. Click Add a Group to open the Add a new Group pop-up
window:

Group Name: Al Permissions

Fleasze check the ahilities you wish to give this admin.

User Profiles User Groups
Gauges _Alents
|Adming Frobe
|Backup/Restare Reparter
(Admin Groups _|Bandwidth Gauges

Submit

Fig. 2:2-2 Add a new Group

2. Type in up to 32 characters for the Group Name.

TIP: You may want to name the group for the type of permissions
to be assigned. This will distinguish the name from other names,
such as those set up for user groups.

3. By default, “Gauges” is selected and therefore greyed-
out. This indicates the administrator to be added will be
able to view and modify gauge content. Click the appro-
priate checkbox(es) to specify the type of access the
administrator will be granted on the TAR console or its
related devices:

» User Profiles - manage a list of end users’ logged
events

» Admins - manage group administrator profiles

» Backup/Restore - perform a backup and/or restoration
on the TAR server

* Admin Groups - manage administrator groups
» User Groups - manage user groups
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» Alerts - manage alerts that indicate if gauges are close
to—or have reached—their established upper thresh-
olds

* Probe - access the R3000 application’s Real Time
Probe feature that lets you monitor end user Internet
usage in real time to verify whether the Internet is
being used appropriately

* Reporter - access the ER application to generate
reports on end user Internet activity

+ Bandwidth Gauges - monitor and manage bandwidth
gauges for inbound and outbound traffic
TIP: To remove a checkmark from any active checkbox
containing a checkmark, click the checkbox.

5. Click Submit to close both pop-up windows. The Group
Name you just entered will appear in the list box the next
time you open the Group Management pop-up window.

View an Admin Group’s Permissions

1. In the Group Management pop-up window, click the
name of the administrator group to highlight the group
name and to activate all buttons:

Group Management x

Groups

All Permissions Add a Group

Bandwidth Gauges =
Edit a Group

Delete a Group

Wigw Permissions

Fig. 2:2-3 Group Management, selection
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2. Click View Permissions to open the Permissions Viewer
pop-up window:

Permissions Viewer *

Group Name: Al Permissions

User Profiles Uzer Groups
Gauges Alerts

Admins Threat Scores
Device Registry Probe
BackupiRestore Reporer

Customn Categories Bandwidth Gauges

Admin Groups

Fig. 2:2-4 Permissions Viewer

3. Note the available features in this pop-up window. In
addition to the selections mentioned in the Add a Group
sub-section, the following administrator functions are
listed:

» Device Registry - add an additional R3000 or view
information about devices connected to the TAR
server

» Custom Categories - maintain the list of library catego-
ries to be used by gauges

» Threat Scores - manage the severity levels for library
categories

These permissions are reserved for the global adminis-
trator and cannot be assigned to group administrators.

4. Click the “X” in the upper right corner of the Permissions
Viewer pop-up window to close it.
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Edit an Administrator Group

1. In the Group Management pop-up window, click the
name of the administrator group to highlight the group
name and to activate all buttons (see Fig. 2:2-3).

2. Click Edit a Group to open the Edit Group pop-up
window:

Edit Group x

Group Name: Al Permissions

Please check the abilities you wish to give this admin

Vilser Profiles Vilser Groups
Gauges Valerts

visdmins VIPrabe

viBackup/Restore VIRepartar

ViAdmin Groups ViBandwidth Gauges

Submit

Fig. 2:2-5 Edit Group

3. Perform any of the following actions:

* Modify the Group Name
» Add functions to be monitored by the administrator
* Remove functions to be monitored by the administrator

4. Click Submit to close the Edit Group and Group
Management pop-up windows.
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Delete an Administrator Group

1. In the Group Management pop-up window, click the
name of the administrator group to highlight the group
name and to activate all buttons (see Fig. 2:2-3).

2. Click Delete a Group to open the Delete Group dialog
box:

Delete Group x

All Permissions

Are you sure you want ta delete this group? All
group associations will be erased.

Cancel Delete Group

Fig. 2:2-6 Delete Group

3. Click Delete Group to remove the administrator group.
This action closes the dialog box and the Group Manage-
ment pop-up window.

NOTE: Clicking Cancel closes the dialog box without removing
the administrator group, and returns you to the Group Manage-
ment pop-up window.
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Chapter 3: Admins Setup

After permission sets have been created, profiles of group
administrators can be set up to monitor user groups.

This function is available to a group administrator only if
permissions were granted by the administrator who set up
his/her account, as detailed in Chapter 2 and in this chapter.

1. In the navigational panel, click Admins to open the Admin
System pop-up window:

Admin System x

_ Active Users - Account Info

isith Employee Name: TAR Login:
tjones i *

Administrator Group: Change Passward
W
Comments:
Work Phone:

Home Phone:

Email:
» User Groups:

s group Edit group
Location: wdd graup dit ot

LDAP Username:

Add New Admin Domain:

Fig. 2:3-1 Admin System

Administrator accounts previously set up display in the
Active Users list box.

NOTE: A global and group administrator will only see the profiles
he/she added. If using IP groups for authentication, “LDAP User-
name” and “Domain” will not display beneath the Location field.

From this pop-up window, you can add an administrator
profile using the wizard, view account information for an
existing administrator, and modify or delete a profile, as
necessary.
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2. After performing the intended actions in this window, click

the “X” in the upper right corner of the window to close it.

Add an Administrator profile

Account Info tab

1. Click Add New Admin to open the Add new Adminis-

trator pop-up window:

Addnew Administrator x
Account Info Contact Info Groups
TAR Login: Administrator Group
piohnson # All Permissions v|*
Password: LDAP Username:
s * pjohnson *
Confirm Password: Domain:

] * LOGO

* Required Hext

Fig. 2:3-2 Add new Administrator, Account Info

. Type in the TAR Login ID the group administrator will

use to access the TAR interface.

. Type in the Password the group administrator will use in

conjunction with the TAR Login, and enter that same
password again in the Confirm Password field. These
entries display as a series of asterisks for security
purposes.

. Select the Administrator Group (previously set up in

the Admins Group menu option) from the available
choices in the pull-down menu.

. If using LDAP authentication, type in the alphanumeric

group administrator’s LDAP Username exactly as set up
on the Active Directory domain in which he/she is regis-
tered.

/\‘3 NOTE: Active Directory is the only LDAP version TAR supports.
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6. If using LDAP authentication, type in the exact charac-
ters for the Active Directory Domain name in which the
group administrator is registered.

NOTE: The LDAP Username and Domain fields do not display if
using IP groups. If the group administrator will be using the
System Tray feature—that triggers an alert in his/her System Tray
if an end user’s Internet usage has reached the upper threshold
established for a gauge’s alert—the LDAP Username and
Domain entered in these fields should be the same as the login
ID and password the group administrator uses to authenticate on
his/her workstation. (See Configuration Section, Chapter 3:
Alerts, Lockout Management and Appendix B: System Tray
Alerts: Setup, Usage for details on setting up and using the
System Tray feature.)

7. Click Next to go to the Contact Info tab.

Contact Info tab

TIP: Click Back at the bottom left of this tab if you need to return
to the Account Info tab.

1. Type in the group administrator’'s Employee Name.

Addnew Administrator x
Account Info Contact Info Groups
Employee Name: Email:
Phil Johnson * piohnsonglogo.cotm *
Work Phone: Location:
714123 4567 *
Home Phone: Comments:

Back et

Fig. 2:3-3 Add new Administrator, Contact Info
2. Type in the group administrator’s Work Phone number,

without entering special characters such as parentheses
(), a hyphen (-), a period (.), or a left slash (/).
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3. Optional: Type in the group administrator's Home Phone
number without entering any special characters.

4. Type in the group administrator’s Email address.

5. Optional: Type in identifying information about the group
administrator’s physical office Location.

6. Optional: Type in any Comments to be associated with
the group administrator’s account.

7. Click Next to go to the Groups tab.

Groups tab

@ TIP: Click Back at the bottom left of this tab if you need to return
to the Contact Info tab.

In this tab you make a selection for any user group(s) to be
monitored by the group administrator. Note that any user
group listed in the Unavailable box has already been
assigned a gauge for monitoring and therefore cannot be
selected again.

Add new Administrator x
Account Info Contact Info Groups
Unavailable Available Assigned *
Al Admin Accounting
Bk Enginesting
Guality Control
Remove

Theze groups belong to a
gauge and are not
assignable Back Submit

Fig. 2:3-4 Add new Administrator, Groups

1. In the Available list box, click the user group to highlight it
and to activate the Add and Remove buttons.

2. Click Add to move the user group to the Assigned list
box.
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TIP: To remove a user group from the Assigned list box, click the
user group to highlight it, and then click Remove to move the user
group back to the Available list box.

3. After selecting each user group to be assigned to the
group administrator, click Submit to close the Add new
Administrator pop-up window and to return to the Admin
System pop-up window. Note that the Active Users list
box now includes the group administrator’s Login ID.

View, Edit Account Info

In the Active Users list box, click the TAR Login ID of the
group administrator to display that user’s account informa-
tion in the Account Info frame:

Admin System | x

_ Active Users s Account Info
STt Employee Name: TAR Login:

T
- Fhil Johnson pichnson

Administrator Group: Change Password

: *
All Permissions Comments:
Work Phone:

714 282 6111 ”

Home Phone:

Email:

pjohnsonglogo.corm e UsEnGTokps;

Edit group
Location: M B
Accounting
LDAP Username:
piohnson %
Add Mews Admin Domain:
*
Delete Admin LOGO save

Fig. 2:3-5 Admin System, selection

If necessary, the following items can be modified:
* Account Info frame fields

« Password
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» User group selection(s)

» User group members

Edit Account Info

1. In the activated Account Info frame:

» The following information can be modified or updated:
Employee Name, TAR Login ID, Administrator Group
selection, Work Phone number, Email address, LDAP
Username or Domain name—the latter two fields are
available if using LDAP.

» The following information can be added, modified, or
deleted: Home Phone number, Location information,
Comments.

» The following actions can also be performed: Change
Password, Add (or remove a user) group, Edit (a user)
group (list).

2. After making any modifications, click Save to save your
entries.
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Change Password

1. In the activated Account Info frame, click Change Pass-
word to open the Change Password pop-up window:

Change Password X

Enter New Password:
Retype Password:

Password changes will go into effect immediately.

Submit

Fig. 2:3-6 Change Password

2. Type in the new password in the Enter New Password
field, and in the Retype Password field. These entries
display as a series of asterisks for security purposes.

3. Click Submit to close the Change Password pop-up
window and to activate the new password.

NOTE: If the administrator whose password was changed is
currently logged into TAR, he/she will need to log out and log
back in again using the new password.

User Groups: Add group, remove a group

1. In the User Groups section of the activated Account Info
frame, click Add group to open the Add new user group
pop-up window:

Add new user group x|

Unavailable Available Assigned
Admin Accounting

Engineering

Quality Contral add

Remaove

These groups belong to a
gauge and are not
assignable Submit

Fig. 2:3-7 Add new user group
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2. Select the user group from the Available list box, and
then click Add to move the user group to the Assigned
list box.

NOTE: A user group previously saved in the Assigned list box
can be moved back to the Available list box, but at least one user
group must be included in the Assigned list box in order to save
your entries.

4. After adding and/or removing user groups to/from the
Assigned list box, click Submit to close the Add new user
group pop-up window, and to clear the entries in the
Account Info frame in the Admin System pop-up window.

User Groups: Edit group

1. In the User Groups section of the activated Account Info
frame, select the user group in the list box to highlight it
and to activate the Edit group button.

2. Click Edit group to open the Edit a User Group pop-up
window (see Fig. 2:1-5), and follow the steps in Chapter
1: User Groups Setup, Edit a User Group sub-section.
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Delete Admin

1. In the Admin System window, click the Login ID of the
group administrator to highlight it and to activate the
elements in the window (see Fig. 2:3-5).

2. Click Delete Admin to open the Delete Administrator
dialog box:

Delete Administrator x

pjohnson

Are you sure you want to delete this
administrator?

Cancel Dreleta Admin

Fig. 2:3-8 Delete Administrator
3. Click Delete Admin to close the dialog box and to
remove the group administrator profile.

NOTE: Clicking Cancel closes the dialog box without removing
the group administrator profile, and returns you to the Admin
System pop-up window.
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CONFIGURATION SECTION

Introduction

The Configuration Section of this user guide is comprised of
four chapters with information on configuring and using TAR
to immediately alert you of any end user Internet activity not
within your organization’s Internet usage policies:

36

Chapter 1: Threat Score Setup - This chapter explains
how the global administrator assigns a threat score
“‘weight” to each library category on the R3000
connected to this TAR server. A threat score is a compo-
nent that influences gauge movement.

Chapter 2: Custom Gauge Setup, Usage - This chapter
explains how gauges are configured and monitored.

Chapter 3: Alerts, Lockout Management - This chapter
explains how alerts are set up and used, and how to
manage end user lockouts.

Chapter 4: Analyze Web Usage Trends - This chapter
explains how URL trend reports are used for assessing
end user Internet/network activity. For additional or
historical information about end user Internet usage
trends, the R3000’s Real Time Probe interface—and the
ER’s Web Client reporting application, if the ER server is
installed and connected to the R3000—can be accessed
from the TAR interface.
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Chapter 1: Threat Score Setup

After setting up group administrators with access to the TAR
server, the global administrator should assign a threat score
“weight” to each library category on the R3000 connected to
TAR. A threat score is a component that influences gauge
movement.

Anatomy of a Gauge

Understanding the anatomy of a gauge will help you deter-
mine the threat score to assign a library category affecting
that gauge.

The illustration below depicts a URL dashboard gauge and
a library category gauge:

Gauge Name

b N

D -—Threat Level — 7

| L"-‘"-QA | .L..A\x‘
@/ Gauge Scorewl

}
Timespan Threat Score Weight

Fig. 3:1-1 URL dashboard gauge anatomy

The name of the gauge displays above the gauge icon. The
timespan for the gauge’s activity displays beneath the URL
dashboard gauge icon, while the threat score weight
displays beneath the library category gauge icon.

The gauge itself is comprised of three colored sections
above: One of the sections in which the gauge’s dial is posi-
tioned. The bottom section of the gauge contains its numer-
ical score.
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Gauge score methodology

The numerical score displayed inside the URL dashboard
gauge icon is based upon: The library categories included in
the gauge, the threat score assigned to each library cate-
gory, and the total score of all end users assigned to a
specific gauge. The score is calculated as follows: Page
count, plus blocked object count, multiplied by the threat
score assigned to the library category.

For example: A group administrator sets up a custom gauge
labeled “Unacceptable Material” that includes the following
library categories: Pornography/Adult Content, Child
Pornography, and Shopping. Pornography/Adult Content
and Child Pornography have been assigned a threat score
of “3” and Shopping has been assigned a threat score of “2”.
Bob, Larry, and Sue are included as members to monitor in
the custom gauge. In this example, Bob accesses a Web
page categorized as Pornography, and Sue goes to a Web
page categorized as Shopping. As a result of these end
users’ activity, the gauge shows a “score” of “5” (score of “3”
for Bob plus a score of “2” for Sue).
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View Assigned Threat Score Weights

1. In the navigational panel, click Policy to open that menu.

2. Click Threat Score to open the Scoring Weight Editor
pop-up window:

Scoring Weight Editor x

Category Weight

Achwiare

Alcohol

AnimalsiPets

Art

Banneriieh Ads

Books & Literature/ritings
Car Racing

Child Parnography
Comics

Community_Organizations
Cririnal_Skills
Crossword Puzzles

Cults

DatingiPersonals

Dornain Landing

Dubious/Unsavany

Submit

Fig. 3:1-2 Scoring Weight Editor

All library categories set up on the R3000 connected to
this TAR server display in the Category list. By default,

each Category is assigned a threat score Weight of “1”,
indicating a “low” threat.

NOTE: In order to reduce complexity, it is recommended that first
time users of TAR should leave all threat score weights at “1”.

TIP: To sort the list in descending order by either Category or
Weight, click the column header. To sort the list in ascending
order, click the column header again.

3. After performing the intended actions in this window, click
the “X” in the upper right corner of the window to close it.

8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE 39



CONFIGURATION SECTION CHAPTER 1: THREAT SCORE SETUP

Assign a Threat Score Weight

1. Click the Category to highlight it.
2. Click in the Weight column to make the field editable.
3. One of the following entries can be made:
+ Enter 1 to assign a low threat score for the least
dangerous sites, such as those in the News category

» Enter 2 to assign a medium threat score for mid-level
threats, such as Shopping or Sports categories

+ Enter 3 to assign a high threat score for the most
dangerous sites, such as those in the Child Pornog-
raphy category

4. After modifying all threat scores, click Submit.
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Chapter 2: Custom Gauge Setup, Usage

With threat score weights established, a group administrator

can begin setting up gauges for monitoring end users’
Internet activity.

1. In the navigational panel, go to the URL Dashboard and

click Gauges to open the Gauge Management pop-up
window:

Gauge Management

Current Gauge Groups
Adult Content

Bandwidth

Illegal

Security

Shopping

Gauge Components

Lower Limit: Upper Limit: Timespan {minutes):

Add Gauge Group Edit Gauge Group Delete ¢

Fig. 3:2-1 Gauée Management

By default, the Current Gauge Groups include: Adult
Content, Bandwidth, lllegal, Security, Shopping.
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2. In the Current Gauge Groups list box, click the gauge

name to display a list of library categories and threshold
criteria set up for that gauge:

Gauge Management
Current Gauge Groups

Bandwidth

Gauge Components
Child Parnography
Explicit_Art

Illegal OhbscenefMasteless
Security FornographyiAdult Content
Shopping R_Rated

Lower Limit: 0 Upper Limit: 200

Timespan {minutes): 15

Add Gauge Group Edit Gauge Group Delete Gauge Group

Fig. 3:2-2 Gauge Management, Gauge Components

3. To exit this window, click the “X” in the upper right corner
of the window to close it.

Add a Gauge

In the Gauge Management window, click Add Gauge

Group to open the Add a new Gauge Group pop-up
window:

Add anew Gauge Group

Gauge Information What categories will this Gauge monitor?
Flease add the last information
about this Gauge Group Available Categories

WaolP

» Assigned Categories

| Manga
Group Narme 4 Weapons Movies_&_Telewigion
Manga " | WeathenTraffic Comics
Lower Lirnit value Web Host e MySpace
1 & | Web Logs/Persanal Pages g

Wyeh-hased Proxies/Anonymizers

Upper Limit Yalue . \eh_Based_Email Remove
200 * | Web_Based_Mewsgroups
Timespan in minutes (1-50 Onky) Web Based Storate
15 i Update List Inclusions Mext

Fig. 3:2-3 Add a new Gauge Group
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Add Gauge Information

In the Gauge Information box:

1. Type in at least four characters for the Gauge Name
using upper and/or lowercase alphanumeric characters,
and spaces, if desired.

2. Type in the Lower Limit Value of the floor for any gauge
activity. The recommended value is 0 (zero).

3. Type in the Upper Limit Value of the ceiling for gauge
activity. The recommended value is 200. This can be
adjusted after using TAR for awhile and evaluating
activity levels at your organization.

4. Type in the Timespan in minutes (1-60 Only) for
tracking gauge activity; usually 75 minutes. The
timespan will always keep pace with the current time
period, so that if a timespan of 15 minutes is specified,
the gauge will always reflect the most recent end user
activity from the past 15 minutes.

Select Library Categories

Next, specify which library categories the gauge will use for
monitoring end user activity.

NOTE: At least one library category must be selected when
creating a gauge. The maximum number of library categories that
can be selected is 15.

1. From the Available Categories list box, select the library
category to highlight it.

2. Click Add to move the library category to the Assigned
list box.

@ TIP: To remove a library category from the Assigned list box, click
the library category to highlight it, and then click Remove to move
the category back to the Available Categories list box.
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Assign User Groups

To assign user groups to be monitored by the gauge:

1. Click Inclusions to open the Assign Groups pop-up
window:

Assign Groups x

Only groups assigned to this gauge will be counted towards
its score.

Assigned Groups
All Arcounting
Admin
Engineeting
Quality Gontrol
Add

Remave

Apply Changes

Fig. 3:2-4 Assign Groups

NOTE: The “base group” displays in the Assigned list box by
default but can be removed. This group consists of all end users
whose network activities are set up to be monitored by the desig-
nated group administrator.

2. From the Groups list box, select the user group to high-
light it.

3. Click Add to move the user group to the Assigned list
box.

TIP: To remove a user group from the Assigned list box, click the
user group to highlight it, and then click Remove to move the
group back to the Groups list box.

4. After adding groups, click Apply Changes to close the
Assign Groups pop-up window, and to return to the Add a
new Gauge Group pop-up window.
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5. Click Next to open the second Add a new Gauge Group
pop-up window that includes information about the
components of the gauge.

View, edit library components

In the second Add a new Gauge Group pop-up window,
view and edit settings for any library category set up for the

gauge:
Add a new Gauge Group x
Please set the weights for the components of this
gauge.
Lower Limit  Upper Limit
Manga o
Lower Limit  Upper Limit
Movies_&_Television ]
Lowier Limit  Upper Limit
Comics b
Lower Limit  Upper Limit
MySpace b ] [200
Set a gauge method Al

Fig. 3:2-5 Add a new Gauge Group, gauge components

1. The floor and ceiling threshold settings that were estab-
lished for the gauge group display in the Lower/Upper
Limit fields of each library category. These values can be
edited, as necessary.

2. If necessary, make a selection from the Set a gauge
method pull-down menu to change the Internet usage
method(s) to be used by the gauge: All (default),
Keyword, URL, Others (passed categories).

NOTE: If the selected gauge method is “Keyword” or “URL”, Filter
Options for end user profiles on the R3000 used with TAR must
have "Search Engine Keyword Filter Control" or "URL Keyword
Filter Control" enabled.
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3. Click Next to close the Add a new Gauge Group windows
and to display the new gauge in the URL dashboard
gauge view:

P e

\gm‘ g‘ Eﬁ‘

\JV\U\_/Q/

Fig. 3:2-6 New Gauge Group added
Gauge Components and Activity

Types of gauges

There are four types of gauges: URL dashboard gauges,
library category gauges, protocol bandwidth gauges, and
port gauges.

Gauges that display in the URL dashboard are comprised of
library categories. Library category gauges display in a pop-
up window for the URL dashboard gauge.

Inbound/Outbound protocol bandwidth gauges are
comprised of ports. Port gauges display in the a pop-up
window for the protocol bandwidth gauge. (See Bandwidth
Management Section.)

46 8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE



CONFIGURATION SECTION CHAPTER 2: CUSTOM GAUGE SETUP, USAGE

Read a gauge

Gauges become active when end users access URLs/ports
included in that gauge. Activity is depicted by the position of
the dial within the gauge—qgreen (safe) section, yellow
(warning) section, or red (network threat) section—and by a
numerical “score” displayed in the middle of the gauge icon.
This score is based upon the type of Internet activity, threat
score, timespan, and upper and lower thresholds estab-
lished for the gauge.

The score displayed in the middle of the gauge icon will
always reflect activity from the most recent past number of
specified minutes set up in the timespan, unless gauge
settings were manually changed and saved, at which point
the gauge is reset.

If the threat for a gauge is currently low or medium, the
score displays in black text. If the threat for a gauge is high
(exceeding 66 percent of the ceiling established for a gauge
group or gauges contained within the group), the score
displays in flashing red text. However, if the score drops
below 66 percent within the timespan set up for the gauge,
the text changes from blinking red to solid black again.

If a gauge group (“parent” gauge) displays flashing red text
while its dial is positioned in the green or yellow sections,
this is indicative that the dial on at least one “child” gauge
contained within the gauge group is currently positioned in
the red section.

The image to the right shows the URL dash-

board’s Bandwidth gauge, comprised of e
several library category gauges. Note the .
timespan for gauge activity displays beneath @//
the gauge icon. In this example, the hit score :
displays flashing in red and the dial is posi-

tioned in the red section of the gauge, currently indicating a
high threat score for this gauge. The source of the threat

can be investigated by drilling down into the gauge. It may
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be that one or more library categories within the gauge
currently have a high score, and that one or more end users
are responsible for this threat.

Inbound/Outbound protocol bandwidth gauges also display
the timespan for gauge activity beneath the gauge icon.
However, unlike URL dashboard gauges, instead of
displaying the total hit score in the middle of the icon,
protocol bandwidth gauges display the total byte score. As
with URL dashboard gauges, the score in the middle of the
icon displays in flashing red text if activity registers in the
upper threshold limit established for the gauge. (See Band-
width Management Section.)

The image to the right shows a gauge for the
Internet_Radio library category in the URL e
dashboard’s Bandwidth gauge. Note the -
Threat Rating displays beneath the gauge w/
icon. In this example, the text displays in black

and the dial is positioned in the green section

of the gauge, indicating that there is no immediate threat for
this library category. If a high threat score displays for any
library category, the source of the threat can be investigated
by drilling down into the gauge.
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Modify a Gauge

Edit gauge settings

To edit an existing gauge, click Gauges in the navigational
panel to open the Gauge Management pop-up window:

Gauge Management

Current Gauge Groups

Gauge Components
Adult Content

Camics
Bandwidth Manga
lllegal Movies_&_Television
Security
Shopping

Lower Limit: 0 Upper Limit: 200 Timespan (minutes): 15

Add Gauge Group Edit Gauge Group Delete Gauge Group

Fig. 3:2-7 Group Management, edit gauge

1. Inthe Current Gauge Groups list box, select the gauge to
be edited. This action highlights the gauge name and
populates the Gauge Components box with a list of
library categories set up to be monitored by that gauge.

2. Click the Edit Gauge Group button to open the Edit
Gauge Group pop-up window:

Edit Gauge Group

Gauge Information VWhat categories will this Gauge monitor?
Please add the last information
about this Gauge Group Available Categories

» Assigned Categories
walP

> Camics
Group Narne. Wieapons Manga
Wanga ¥ wieathenTraffic Movies_g_Television
Lower LirmitYalue IATelaleE] tEpace
1 % | Wieb LogsiPersonal Pages Add

Web-based ProsesiAnaonymizers

Upper Limit Value Weh_Based_Email Remaove
200 T | wieh_Based_Newsgroups
Timespan in minutes {1-60 Only) Weh Based Sloraue
15 P Update List Inclusions | Next

Fig. 3:2-8 Edit Gauge Group
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NOTE: The Edit Gauge Group pop-up window is also accessible
by right-clicking a URL dashboard gauge, and then selecting Edit
Gauge Group from the pop-up menu (see Fig. 3:2-12).

3. Edit any of the following criteria, as necessary:

* Gauge Information - Gauge Name, Lower/Upper Limit
Value(s), Timespan in minutes (see Add Gauge Infor-
mation)

» Assigned Categories (see Select Library Categories)
» Assigned Groups (see Assign User Groups)

4. Click Next to go to the second Edit Gauge Group pop-up
window:

Edit Gauge Group x

Please set the weights for the companents

of this gauge
Lower Limit  Upper Limit
Comics b 200
Lower Limit Upper Limit
Manga o

Movies_&_Television b
MySpace b 200

Set a gauge method Al

Save Changes

Fig. 3:2-9 Edit a Gauge Group, gauge components

5. Edit any of the following criteria, as necessary:
* Lower/Upper Limit fields for gauge activity in each
library category
* Internet usage method for the gauge.

6. Click Save Changes to close the Edit Gauge Group
windows and to return to the dashboard with the Gauges
panel.

50 8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE



CONFIGURATION SECTION CHAPTER 2: CUSTOM GAUGE SETUP, USAGE

NOTE: When saving your edits, the gauge hits and score are
reset to zero (“0”).

Hide, Show a URL Gauge

If you only want to view certain URL gauges and their asso-
ciated library categories, options are available to hide spec-
ified URL gauges.

Temporarily hide a URL gauge

To hide a URL gauge for the current session only:

1. In the URL dashboard, right-click the gauge to open its
pop-up menu (see Fig. 3:2-12).

2. Select Hide Gauge to remove the URL gauge from the
current view.

NOTE: Using this option, any gauges hidden during this session
will reappear in the next session.

Save settings for hiding a URL gauge

To permanently hide a URL dashboard gauge:

1. Click Gauge View in the URL Dashboard section of the
navigational panel to open the Edit Gauge Visibility pop-
up window:
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Edit Gauge Visibility x

= Gauges
& Adult Content
&% Security

B @ Shopping
Online Auction
Online Trading/Brokera
& &% Bandwidth
& Peerdo-peenFile_Shari

& Internet_Radio

& Search_Engines

& Image Servers & Searc

& Streaming_Media

Svolp

@ \Weh_Rased_Storage
B lllegal

4 »

hidefshow Save Visibility

Fig. 3:2-10 Edit Gauge Visibility

This window includes a list of URL gauges, each
preceded by a gauge icon. Gauges that are currently
visible in the URL dashboard include a green circle with a
checkmark in the lower right corner of the gauge icon.
Gauges that are currently hidden from view include a red
circle with an X in the lower right corner of the gauge
icon.

TIP: To view the library categories included in a URL gauge, click
the URL gauge name to open it. Click the gauge name again to
close the list of library categories.

2. Select the URL gauge to be hidden by clicking it.

3. Click the hide/show button to change the icon from the
green circle with a checkmark to a red circle with an X.
This action also removes the URL dashboard gauge from
the current view.

TIP: To redisplay the URL dashboard gauge in the current view,
select the gauge and click the hide/show button again.

4. Click Save Visibility to save your settings. These
settings will remain the next time you log into the TAR
server.
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NOTE: Gauges that are hidden will not display in trend reports
(see Chapter 5: View URL Trend Reports).

Delete a Gauge

1. To delete a gauge, begin by performing one of two
actions:

* Click Gauges in the navigational panel to open the
Gauge Management pop-up window (see Fig. 3:2-7).
In the Current Gauge Groups list box, select the gauge
to be deleted. This action highlights the gauge name
and populates the Gauge Components box with a list
of library categories set up to be monitored by that
gauge.

Click the Delete Gauge Group button to open the
Delete Gauge dialog box:

Delete Gauge x

General Activity

Are you sure you want to delete this gauge?
All associated alerts will also be removed.

Cancel Delete Gauge

Fig. 3:2-11 Edit Gauge Group

Or:

* Inthe URL dashboard, right-click the gauge to open its
pop-up menu:
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Fig. 3:2-12 Gauge pop-up menu

Select Delete Gauge Group to open the Delete Gauge
dialog box (see Fig. 3:2-11).
2. Click Delete Gauge to remove the gauge. This action

closes the dialog box and returns you to the URL dash-
board, removing any associated alerts.

NOTE: Clicking Cancel closes the dialog box without removing
the gauge, and returns you to the Gauge Management pop-up
window.
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View End User Gauge Activity

There are several ways to access information on end user
gauge activity:

» Overall end user gauge activity - For a snapshot of all
current gauge activity ranked in order by the highest to
lowest end user score, use the Overall Ranking option
(see View Overall Ranking). This option also lets you drill
down and view information on gauges affected by a
specified end user.

» End user activity by URL gauge - For a snapshot of a
URL gauge’s current activity ranked in order by the
highest to lowest end user score, use the Ranking Table
option (see View a URL gauge ranking table).

* End user activity by library category gauge - For a snap-
shot of a library category gauge’s current activity ranked
in order by the highest to lowest end user score, use the
library category ranking table option (see View a library
category ranking table).

8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE 55



CONFIGURATION SECTION CHAPTER 2: CUSTOM GAUGE SETUP, USAGE

View Overall Ranking

To view details about current gauge activity for all end users
affecting gauges:

1. In the URL Dashboard section of the navigational panel,
click Overall Ranking to open the Overall Rankings pop-
up window:

Overall Rankings x

Name | Score
| Shiontana

RReynolds a7
TSmith 86
TWwoods 62
MSaunders 15
GArmstrang q
FFarmar B

il User Summary

Fig. 3:2-13 Overall Rankings

This window includes rows of records for each end user
who is currently affecting one or more gauge. For each
record in the list, the following information displays:
Name (username/IP address), and corresponding Score.
End users are ranked in descending order by their score.

2. To drill down and view additional information about an
end user’s activity, click the Name to highlight it.

3. Click User Summary to open the Individual User View
pop-up window (see Fig. 3:2-17), and perform any of the
actions described for this window (see Monitor, Restrict
End User Activity).

4. Click the “X” in the upper right corner of this pop-up
window to close it.

56 8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE



CONFIGURATION SECTION CHAPTER 2: CUSTOM GAUGE SETUP, USAGE

View a URL gauge ranking table

To view details about a specified URL gauge’s current
activity:

1. Right-click the URL dashboard gauge to open its pop-up
menu (see Fig. 3:2-12).

2. Choose View Rankings to open the URL gauge’s ranking
table pop-up window:

Bandwidth x

Mame |Score

MSaunders 12

'
User Summary

Fig. 3:2-14 URL gauge ranking table

This window includes rows of records for each end user
who is affecting this URL gauge. For each record in the
list, the following information displays: Name (username/
IP address), and corresponding Score. End users are
ranked in descending order by their score.

NOTE: The URL gauge’s ranking table pop-up window is also
accessible via the following options:

* Double-clicking a URL dashboard gauge to open the URL
gauge’s pop-up window, and then clicking the Ranking Table
button.

* Right-clicking a URL dashboard gauge, selecting View Gauge
Details from the pop-up menu (see Fig. 3:2-12) to open the
URL gauge’s pop-up window, and then clicking the Ranking
Table button.
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3. To drill down and view additional information about an
end user’s activity, click the Name to highlight it.

4. Click User Summary to open the Individual User View
pop-up window (see Fig. 3:2-17), and perform any of the
actions described for this window (see Monitor, Restrict
End User Activity).

5. Click the “X” in the upper right corner of this pop-up
window to close it.

View a library category gauge ranking table

To view details about a specified library category gauge’s
current activity:

1. Right-click the URL dashboard gauge to open its pop-up
menu (see Fig. 3:2-12).

2. Choose View Gauge Details to open a pop-up window
displaying library category gauges comprising the URL
dashboard gauge:

Bandwiih

— il — )

-------------

Fig. 3:2-15 Gauge pop-up window

NOTE: The total of all library category gauge scores equals the
score of the URL dashboard gauge.
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3. Click the library category gauge to open its pop-up
window:

Search_Engines

Name | Score
mM3aunders 14

FFarmer 3
GArmstrang 1

il
User Summary

Fig. 3:2-16 Library category gauge ranking table

This window includes rows of records for each end user
who is affecting this library category gauge. For each
record in the list, the following information displays:
Name (username/IP address), and corresponding Score.
End users are ranked in descending order by their score.

NOTE: The library gauge’s ranking table pop-up window is also
accessible by double-clicking a URL dashboard gauge to open
the URL gauge’s pop-up window, and then clicking a library cate-

gory gauge.

4. To drill down and view additional information about an
end user’s activity, click the Name to highlight it.

5. Click User Summary to open the Individual User View
pop-up window (see Fig. 3:2-17), and perform any of the
actions described for this window (see Monitor, Restrict
End User Activity).

6. Click the “X” in the upper right corner of this pop-up
window to close it.
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Monitor, Restrict End User Activity

The Individual User View window lets you view/restrict an
end user’s use of the Internet/network.

1. From any of the user ranking windows, with the end
user’s record selected, click User Summary to open the
Individual User View pop-up window:

Individual User View

Gauge Readings:

Groups

TWoods

Adult Content a
lNegal 1)

Shopping 0 IP: 200.100.10.4

Lockout

Category View

Score Grand Total: 44

Fig. 3:2-17 Individual User View

This window contains Gauge Readings for each URL
gauge Name, ranked in descending order by the end
user’s Score for the corresponding gauge. The user-
name/IP address and end user’s IP display in the Groups
box, along with the Lockout and Category View button.
The Score Grand Total for all of the end user’s gauge
readings displays at the bottom of the window.

TIP: To sort the list in descending order by either Name or Score,
click the column header. To sort the list in ascending order, click
the column header again.

2. After performing the intended actions in this window, click
the “X” in the upper right corner of this window to close it.
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View a list of URLs accessed by the end user

To monitor an end user’s Internet activity:

1. In the Individual User View pop-up window (see Fig. 3:2-
17), select the URL dashboard gauge to highlight it.

2. Click Category View to open the View by Hits pop-up
window:

View by Hits

Category | Hits [Score

Search Engines
YolP i}
Streaming_Media 1]
Web_Based_Storage 1]
Feer-to-peerfFile_Sharing 0
Internet_Radio 1]
Image Servers & Search E 0

0
0
0
0
0
0

Category Details

Fig. 3:2-18 View by Hits

A list of each library Category gauge and its corre-
sponding Hits and Score for the URL dashboard gauge
displays in this window.

3. Select a library category gauge to highlight it.
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4. Click Category Details to open the View Details pop-up
window:

View Details x

URL | Timestamp -
hitp:fsg.answers yahoo.comicommoniutiiks-ga-kh-handler php?method=getikidData&kid 13:11:48M11:14:2006
hitp:irove be yahoo comib ?P=Ar8rTSFJuByBOGNORVajP g1 g0QuhZEVaMUwaABMs 2 &T=15an 13:11:08/11:14:2006
http:row beyahoo.comib ?P=YmuBYstU0GmBOEN0RY o] Pmxe0QuhZEYaMUBAATRMET=1 13:11:08/1:14.2006
hitp:ifrowe beyahoo.comib ?P=YmuBYstU0QmMBQEN0RYo PmxelQuhZEVaMUSAATRMET=1 13:11:0311:14:2006
hitp:ifwww google cormfurl?sa=T&ot=res&ed=1&urk=http:sg.answers yahoo.comiquestion/ 13:11:03011:14:2006

hitp:ifsg. answers yahoo comfguestioniindex?qid=200610311129458483CTT 13:11:0311:14:2006
http:iwww google com/search?hl=en&lr=&q=potato+bugs+dangerous 13:10:58M1:14:2006
hitp:ifwww.google.com/search?hi=ené&lr=&g=potato+bugs+poisonous 1310:4311:14:2008
hitp:iwww google cormisearch?hl=en&lr=&g=silkworms+blackbern+leaves 1310:03M1:14:2006
hitp:ifwww google corm/search?hl=en&lr=&g=silkworms+blackberry&binG=Search 13:09:58M11:14:2006
http:ivwww google com/search?hl=en&lr=&q=silkworms+blackberry 13:09:53M1:14:2006
hitp:ifwww google comiurl?sa=Ta&rt=reséed=3&url=http Sy madsci.org/postsiarchives/r 13:09:1311:14:2006
hitp:iwww.google cormfsearch?hl=en&lr=&g=silkworms+feed+an 13:08:5311:14:2006
hitp:ifwww google corm/search?hl=en&lr=E&g=papua+new+guinea+save +rainforest 13:08:1811:14:2006 b

Fig. 3:2-19 View Details

A list of each URL and corresponding Timestamp (using
military time in the HH:MM:SS/MM:DD:YYYY format) for
the time the URL was accessed in displays in this
window for that library category.

TIP: To sort the list in descending order by either URL or Time-
stamp, click the column header. To sort the list in ascending
order, click the column header again.

NOTE: Drill Down Reports in the Enterprise Reporter Web Client
should be used to obtain a list of clickable URLs. The ER Web
Client is accessible by going to the navigational panel and
selecting Report/Analysis > ER Reporter.

5. Click the “X” in the upper right corner of the View Details
and View by Hits windows to close them.
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Manually lock out an end user

To prevent the end user from accessing specified URLs, the
Internet, or the entire network:

1. Click Lockout to open the Lockout dialog box:

Lockowut x

Are you sure you wish to
lock out this user?

Severity: Ly -

Mo fes

Fig. 3:2-20 Lockout

2. Specify the Severity of the lockout from the choices in
the pull-down menu:

* Low - this selection lets you choose which library cate-
gory’s contents the end user will not be able to access

* Medium - this selection locks out the end user from
Internet access

 High - this selection locks out the end user from all
network access

3. Click No to close the dialog box, or click Yes to proceed.

* If a “Low” severity was selected, clicking Yes opens
the Lockout by Categories pop-up window:

Lockout by Categories x

Please select the categories you wish to
lock this user out of

Available Categories Assigned Categories
Adware & Search Engines
Alcohol
alis test categary
amcal
AnimalsiFets
At
Bannetheh Ads REMOsE

Add

Books & LiteratureMvritings
Chat
Child Parmography

Update List Mext

Fig. 3:2-21 Lockout by Categories
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a. From the Available Categories list box, select the
available library category containing URLs the end
user should not access.

b. Click Add to move the library category to the
Assigned Categories list box.
TIP: To remove a library category from the Assigned Categories
list box, click the library category to highlight it, and then click
Remove to move the category back to the Available Categories
list box.

c. After adding all library categories, click Next to
open the alert box stating: “The user has been
locked out.”

d. Click the “X” in the upper right corner of the box to
close it.

 If a “Medium” or “High” severity was selected:

a. Clicking Yes in the Lockout dialog box opens the
the alert box stating: “The user has been locked
out.”

b. Click the “X” in the upper right corner of the box to
close it.

NOTE: The end user remains locked out of the specified areas on
the Internet/network until the administrator unlocks his/her work-
station. To “unlock” the end user, go to the Lockout window in the
URL Dashboard section of the navigational panel. For information
on this feature, see Chapter 3: Alerts, Lockout Management.
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End user workstation lockout

The following scenario occurs for the end user when he/she
is locked out:

* Low severity lockout - In this scenario, after attaining the
designated score established for a gauge, when the end
user attempts to access a URL for a library category set
up to be monitored by that gauge, the following lockout
page displays for the end user:

e ® bomres

Fig. 3:2-22 Low severity lockout page

This page contains the following information: message
“Access Denied by TAR”, USER name/IP address, URL
denied access, Category in which the URL resides, and
end user’s Score.

* Medium severity lockout - In this scenario, after attaining
the designated score established for a gauge, when the
end user attempts to access any URL, the following
lockout page displays for the end user:
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'3 Wtp:tAwww.google.com/ - Microsafl Internet Explorer
Fie Edt View Favortes Tools Hep

Qe - PREE A ) sewch Favortes 4%) kg - o Bl

Address | #] hitp: ffemaw. google.com/

502 Access Densed by 8e6 R3000 Enterprise Filter

£] Done O et

Fig. 3:2-23 Medium severity lockout page

This page contains the following information: “502
Access Denied by 8e6 R3000 Enterprise Filter”.

» High severity lockout - In this scenario, after attaining the
designated score established for a gauge, the end user
will be unable to access the organization’s network.
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Chapter 3: Alerts, Lockout Management

After setting up gauges for monitoring end user Internet
activity, notifications for Internet abuse should be set up in
the form of policy alerts. Alert messages inform the adminis-
trator when an end user has triggered an alert for having
reached the threshold limit established for a gauge. If the
end user was locked out of Internet/network as a result of
his/her Internet activity, the administrator can determine
when to unlock that end user’s workstation.

This function is available to a group administrator only if
permissions were granted by the administrator who set up
his/her account, as detailed in Chapters 2 and 3 of the
Preliminary Setup Section.

1. In the navigational panel, click Policy to open that menu.
2. Click Alerts to open the Alert Manager pop-up window:

Rlert Manager x|l

Current Gauges Current Alerts
Adult Content

Negal
Security
Shopping

Add New Alert Edit Alert Delete Alert View Alert

Fig. 3.'3-% Alertmnager
3. After performing the intended actions in this window, click

the “X” in the upper right corner of the pop-up window to
close it.
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Add an Alert

1. In the Current Gauges box, click the gauge for which an
alert will be created (see Fig. 3:3-1).

2. Click Add New Alert to open the Add a new Alert pop-up
window:

Add anew Alert x

Flease fill outthe fields below to define the alert. Ifyou choose to have Email associated with the
action, enter as many email addresses as required.

Current Gauge
Adult Content
egal
Security

Shopping

Alert Action

Ernail
Lockout
Systerm Tray

Threshald:

Alert Mame: Subrnit

Fig. 3:3-2 Add a new Alert

3. Type in the Alert Name to be used for the alert that will
be delivered to the group administrator.

4. Inthe Threshold field, enter the number for the threshold
limit that will trigger the alert.

NOTE: An alert is triggered for any end user whose current score
for a gauge matches the designated threshold limit. (See Gauge
score methodology in Chapter 1 of this section for information on
how scoring is defined.)

5. In the Alert Action portion of the specify the mode(s) to
use when an alert is triggered:
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* Email - An email alert notifies a group administrator via
email if an end user has reached the threshold limit set
up in a gauge alert.

» Lockout - The Lockout function locks out an end user
from Internet/network access if he/she reaches the
threshold limit set up in a gauge alert.

» System Tray - A TAR Alert message notifies a group
administrator via his/her workstation’s System Tray if
an end user has reached the threshold limit set up in a
gauge alert.

NOTE: The System Tray alert feature is only available if using
LDAP, and is not available if using IP groups.

6. After making all entries in this window, click Submit to
save your entries and to close the Add a new Alert pop-
up window.

Email alert function

Configure email alerts

To set up the email alert function:

1. Click the checkbox corresponding to Email to display the
Email Addresses list box, and associated field and
buttons to the upper right of this window.

2. Type in the email address.

3. Click Add Email to include the address in the Email
Addresses list box.

Follow steps 2 and 3 for each email address to be sent
an alert.

TIP: To remove an email address from the list box, select the
email address and then click Remove Email. Click Submit to save
your settings.
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Receive email alerts

If an alert is triggered, an email message is sent to the
mailbox address(es) specified. This message includes the
following information:

» Subject: Alert triggered by user (username/IP address)

* Body of message: User (username/IP address) has trig-
gered the (Alert Name) alert with a threshold of X (in
which “X” represents the alert threshold) on the (URL
dashboard gauge name) gauge.

Lockout function

Configure automatic lockouts

To set up the lockout function:

1. Click the checkbox corresponding to Lockout to display
the Severity pull-down menu to the right of this window.

2. Specify the Severity of the end users’ lockout:

» Low - choosing this option opens the Lockout by Cate-
gories pop-up window (see Chapter 3: Custom Gauge
Setup, Usage - Flg. 3:2-15). Specify the library cate-
gory containing URLs the end user should not access.

* Medium - choosing this option will lock out an end user
from Internet access if he/she reaches the threshold
limit set up for the gauge.

* High - choosing this option will lock out an end user
from network access if he/she reaches the threshold
limit set up for the gauge.

NOTE: The end user will remain locked out from Internet/network

access until the group administrator unlocks his/her workstation
using the Lockout window.
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System Tray alert function

If using LDAP, to set up the feature for System Tray alerts,
click the checkbox corresponding to System Tray, and
follow the instructions in Appendix B: System Tray Alerts:
Setup, Usage.

NOTE: In order to use this feature, the LDAP Username and
Domain set up in the group administrator’s profile account (see
Chapter 3 in the Preliminary Setup Section) must be the same
ones he/she uses when logging into his/her workstation.

View, Modify, Delete an Alert

1. In the Alert Manager pop-up window’s Current Gauges
box, select the gauge for which an alert will be viewed
and/or modified:

Alert Manager

Current Gauges Current Alerts
Bandwidth Alert

Adult Content

INegal
Security
Shopping

Add New Alett Edit Alert Delete Alert Wiew Alert

Fig. 3:3-5 Alert Manager

This action populates the Current Alerts box with alerts
created for that gauge.

2. Select the alert to be viewed or modified by clicking on it
to highlight it.
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View alert settings

1. In the Alert Manager pop-up window, click View Alert to
open the Alert Viewer pop-up window:

Alert Viewer x
Current Gauges Alerts on Gauge
Adult Content = Bandwidth Alert
Bandwidth |
llegal
Security
Shopping
Email Contacts Alert Name: Bandwidth Alert
pinhnson@logo.com Threshold: 1000

Severity: Low

Lockout Categories:

Peer-to-peerFile_Sharing

Email
Lockout Internet_Service_Provider

- _ Instant_Messaging
System Tray | - o

Fig. 3:3-6 Alert Viewer

The Alert Name, Threshold, and Severity display, along
with any options specified in the Add a new Alert or Edit
an Alert pop-up window. These options include Email
Contacts; checkbox(es) for Email, Lockout, and/or
System Tray features, and Lockout Categories, if a Low
Severity was specified.

NOTE: The System Tray alert feature is only available if using
LDAP, and is not available if using IP groups.

2. Click the “X” in the upper right corner of this pop-up
window to close it.
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Modify an alert

1. In the Alert Manager pop-up window, click Edit Alert to
open the Edit an Alert pop-up window:

Edit an Alert x

Flease fill outthe fields below to define the aler. Ifyou choose to have Email associated with the
action, enter as many email addresses as reguired

Current Gauge Email Addresses
Adult Content = piohnsan@@logo.com

lNegal
Security
Shopping

Alert Action
Remove Email Add Email

VIEmail
viLockout Severity: | Low
ViSystem Tray

Threshold: 500

AlertMame:  Bandwidth Alert Subrmit

Fig. 3:3-7 Edit an Alert

2. The following items can be edited:

» Alert Name

* Threshold

 Alert Action selections: Email, Lockout, System Tray
NOTE: The System Tray alert feature is only available if using
LDAP, and is not available if using IP groups.

* Email Addresses

» Severity selection

3. Click Submit to save your edits, and to close the Edit an
Alert pop-up window.
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Delete an alert

1. In the Alert Manager pop-up window, click Delete Alert
to open the Delete Alert dialog box:

Delete Alert %

Duplicate
Are you sure you want to delete this alert?

Cancel Celete Alert

Fig. 3:3-8 Delete Alert

2. Click Delete Alert to close the Delete Alert dialog box
and to remove the alert from the Current Alerts box.

NOTE: Clicking Cancel closes the dialog box without removing
the alert, and returns you to the Alert Manager pop-up window.
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View the Alert Log

After alerts are sent to an administrator, a list of alert activity
is available for viewing in the Alert Log Viewer.

This function is available to a group administrator only if
permissions were granted by the administrator who set up
his/her account, as detailed in Chapters 2 and 3 of the
Preliminary Setup Section.

1. In the Policy menu, click Alert Log to open the Alert Log
Viewer pop-up window:

Alert Log Viewer

[

Time |user | Atert | Gauge B
Suontans 202200202
RReynolds 202.208.20.1 Bandwidth Alert Bandwidth

15:42:4711:16:2006 SMontana 202208203 Bandwidth Alert Bandhwidth

16:32:46011:16:2006 RReynolds 202.208.20.1 Shopping Alert Shopping

16:65:48/11:16:2006 SMantana 202208203 Adult Content Alert Adult Content

13:21:58/11:16:2006 Stlontana 202.208.20.3 llegal Alert llegal

T 418M116:2006 RReynolds 202.208.201 Shopping Alert shopping

THEIBH116:2006 Shontana 202.208.20.3 Shopping Alert Shopping

1305:5711:16:2006 RReynolds 202.208.20.1 lilegal Alert iegal

12:21:58M1:16:2006 Shontana 202208203 llegal Alert llegal

T1:21:511116:2006 SMontana 202.208.20.3 llegal Alert Illegal

11:20:3111 162006 SMantana 202208203 Alcohol Alert Alcahal

MAGMA1AB:2006 TSrmith 202208202 Security Alert Security

TE16:30M1:19:2006 SMontana 202.208.20.3 lllegal Alert liegal

A2 6:2006 TSmith 202.208.20.2 Alcohol Alert Alcohol

View Aler

Fig. 3:3-9 Alert Log Viewer

The alert log contains a list of alert records for the most
recent 24-hour time period. Each record displays in a
separate row. For each row in the list, the following infor-
mation displays: Time the alert was sent (using the
HH:MM:SS/ MM:DD:YYYY format), User (username/IP
address), IP address, Alert name, Gauge name.

TIP: To sort the list in descending order by any column, click the
column header. To sort the list in ascending order, click the
column header again.

NOTE: If an alert was edited during the most recent 24-hour time
period, any records associated with that alert will be removed
from the alert log.
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2. To view details on an alert, select the alert in the list to
highlight it.

3. Click View Alert to open the Alert Viewer pop-up window
(see Fig. 3:3-6).

4. Click the “X” in the upper right corner of Alert Viewer and
Alert Log Viewer pop-up windows to close them.

Manage the Lockout List

An end user who is manually or automatically locked out
from accessing designated URLs on the Internet or using
the network can only have his/her workstation unlocked by
an administrator.

To view the current lockout list:
1. Go to the navigational panel and select URL Dashboard.

2. Click Lockout to open the View All Lockouts pop-up

View All Lockouts x
Name [P | Tvpe |Severity | Cause | Source | Atertinp | TimeStamp | PUID
Shontana 2022062003 Lockout Low Putomatic Bandwidth Ale 117 13:114:18/11:16:21 11
Shortana 202.208.20.3| Lockout wedium  [Manual | | 11:26:10111:16:2
TSmith 202,208.20.2 Lockout Low Automatic Bandwidth Ale 117 131118M118:2012
RReynolds 202208201 Lockout Low Automatic llegal Alert 1100 MA821111621 8

& Date Range & Gearch Dates

Refresh Unlock User Surmmary

Fig. 3:3-10 View All Lockouts

The lockout list contains records for all end users
currently locked out of the Internet/network. Each end
user’s record displays in a separate row. For each row in
the list, the following information displays: Name (user-
name/IP address); IP address; Type of activity (Lockout);
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Severity of the lockout (Low, Medium, High); Cause of
the lockout (Manual, Automatic); Source of an automatic
lockout (name of the alert); AlertlD for an automatic
lockout (number assigned to the alert by TAR—this
number changes if the alert was edited); TimeStamp for
the alert (using the HH:MM:SS/MM:DD:YYYY format);
PUID (Personal User IDentification assigned by TAR to
the end user).

. After performing the intended actions in this window, click

the “X” in the upper right corner of the pop-up window to
close it.

View a specified time period of lockouts

If the lockout list is populated with many records, using the
Date Range feature will only show you records within the
range of dates you specify.

1.

In the Date Range field, click the E' calendar icon on
the left to open the larger calendar for the current month,
with today’s date highlighted:

4 November 2006 »

s M T T F s

w
.234
s 9

12 12 14 15 18 17 18

=) ] 7

19 20 21 22 23 24 25

26 27 ﬁ 2a a0

TIP: To view the calendar for the previous month, click the left
arrow. To view the calendar for the next month, click the right
arrow.

2. Click the starting date to select it and to close the

calendar pop-up window. This action populates the field
to the left of the calendar icon with the selected date.
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3. Click the B calendar icon on the right to open the larger
calendar for the current month, with today’s date high-
lighted.

4. Click the ending date to select it and to close the
calendar pop-up window. This action populates the field
to the left of the calendar icon with the selected date.

5. Click Search Dates to display records for only the
selected dates.

TIP: Click Refresh to clear all records returned by the search
query, and to display the default records (all lockout records) in
the window.

6. Click the “X” in the upper right corner of the pop-up
window to close it.

Unlock a workstation

1. In the View All Lockouts pop-up window, click the record
to highlight it.

2. Click Unlock to unlock the end user and to remove his/
her record from the window.

NOTE: By unlocking an end user’s workstation, all records in this
window pertaining to that end user are removed from this window.
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Chapter 4: Analyze Web Usage Trends

When analyzing end user Internet usage trends, URL trend
reports help you configure gauges and alerts so you can
focus on current traffic areas most affecting the network.

If more information is required in your analysis, the R3000’s
Real Time Probe tool—or the Enterprise Reporter’'s Web
Client, if the ER server is installed and connected to your
R3000—can be accessed via the TAR interface so you can
generate customized reports to run for a time period of your
specifications.

These functions are available to a group administrator only
if permissions were granted by the administrator who set up
his/her account, as detailed in Chapters 2 and 3 of the
Preliminary Setup Section.

8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE 79



CONFIGURATION SECTION CHAPTER 4: ANALYZE WEB USAGE TRENDS

View URL Trend Reports

There are two types of URL trend reports that can be gener-
ated on demand to show total gauge score averages for a
specified, limited time period: All Visible Gauges trend chart,
and specified URL dashboard gauge trend chart.

View all URL dashboard gauge activity

1. In the navigational panel, click Report/Analysis to open
that menu.

2. Click Trend Chart to open the All Visible Gauges trend
chart:

All Visible Gauges

Score
150.

Enabled
Gauges
120.0 MAdult Content
v Security
vIShopping
o VBandwidth
villegal

30.0
Timespan
et o e Qne Hour -
P i i

0.
11-30-2008 10:20:00 1302008 10:50:00 11302008 11:20:00
All Yisible Gauges

®adult Content ®Security ® Shopping  Bandwidth ®Illegal

Fig. 3:4-1 All Visible Gauges trend chart

By default, this chart contains the following information:
graphical depiction of last hour’s end user Score for all
visible URL dashboard gauges; fixed time increments
(using the MM-DD-YYYY HH:MM:SS format); all
Enabled Gauges selected; Timespan drop-down menu,
and a color-coded key listing All Visible Gauges.

NOTE: A URL dashboard gauge is made invisible or visible via
settings in the Gauge View window (see Hide, Show a URL
Gauge in Chapter 3: Custom Gauge Setup, Usage).
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3. After you have viewed the information in this chart, click
the “X” in the upper right corner of the window to close it.

View activity for a specified URL gauge

1. In the URL dashboard gauge view, double-click the
gauge to open a pop-up window displaying library cate-
gory gauges comprising the URL dashboard gauge (see
Fig. 3:2-15).

2. Click Trend Chart to open the Trend Chart for that URL
dashboard gauge:

Trend Chart for Bandwidth

Score
80

Enabled
Categaries

£4.0] VImage Servers & Search |
VInternet_Radio
V|Peer-to-peeriFile_Sharing
V| Search_Engines

V| Streaming_Media

32,0 VvolP
Meh_Based_Storage

Timespan
oc One Hour
14132006 15:40:00 11-13-2006 16:10:00 11-13-2006 16:40:00

Bandwidth

®Toral ®Straaming_Media ®lmage Servers & Search Engines  Web_Based_Storage ®ueIP ®Saarch_Engines

®peer-ro-peer/File_Sharing ® Interner_Radia

Fig. 3:4-2 Trend Chart for selected URL dashboard gauge

By default, this chart contains the following information:
graphical depiction of last hour’s end user Score for that
URL gauge; fixed time increments (using the MM-DD-
YYYY HH:MM:SS format); all library categories (Enabled
Categories) selected; Timespan drop-down menu, and a
color-coded key listing all library categories for that
gauge.

3. After you have viewed the information in this chart, click
the “X” in the upper right corner of the window to close it.
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Suppress specified scores

To view only specified gauge scores in the chart, click the
checkbox corresponding to the gauge to suppress graphical
information for that gauge from displaying in the chart. To re-
enable displaying information for that gauge, click the
checkbox again.

View scores for a different time period

To view a different time period of gauge score averages,
make a selection from the Timespan pull-down menu:

* One Hour - this selection displays gauge score averages
in 10 minute increments for the past 60-minute time
period

» Six Hours - this selection displays gauge score averages
in 30 minute increments for the past six-hour time period

» Twelve Hours - this selection displays gauge score aver-
ages in one hour increments for the past 12-hour time
period

* One Day - this selection displays gauge score averages
in one hour increments for the past 24-hour time period

* One Week - this selection displays gauge score aver-
ages in one-day increments for the past seven-day time
period

* One Month - this selection displays gauge score aver-
ages in one-day increments for the past month’s time
period
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Access Real Time Probe, Web Client

R3000 Real Time Probe reports can be generated to obtain
more information about end user Internet usage trends. If an
ER server is connected to the R3000, ER Web Client
reports can be generated to view historical Internet usage
trend data.

Access the R3000 Real Time Probe tool

1. In the navigational panel, click Report/Analysis to open
that menu.

2. Click R3000 Probe to launch the login window of the
R3000 Real Time Probe interface.

NOTE: See the Reporting screen chapter from the Global Admin-
istrator Section of the R3000 User Guide for information on
configuring and using Real Time Probes.

Access the ER Web Client application

1. In the navigational panel, click Report/Analysis to open
that menu.

2. Click ER Reporter to launch the login window of the ER
Web Client application.

83
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BANDWIDTH MANAGEMENT SECTION

Introduction

Whereas the URL dashboard Bandwidth gauge monitors
end user Internet activity by the number of URL hits, gauges
in the Bandwidth section of the interface monitor incoming
and outgoing end user bandwidth traffic by the number of
bytes.

The Bandwidth Management Section of this user guide is
comprised of three chapters with information on monitoring
inbound and outbound traffic, adjusting bandwidth gauge
settings, and using reports for analyzing network traffic data
in order to more effectively manage your resources.

* Chapter 1: Monitor Bandwidth Gauges - This chapter
explains how bandwidth gauges are used for monitoring
inbound and outbound traffic.

» Chapter 2: Modify Bandwidth Gauges - This chapter
explains how to modify bandwidth gauge settings so you
are alerted only when needed to safeguard your network.

* Chapter 3: View Bandwidth Trend Reports - This chapter
explains how to analyze data in bandwidth trend reports.
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Chapter 1: Monitor Bandwidth Gauges

Bandwidth gauges work similarly to URL dashboard
gauges, except these gauges solely monitor inbound or
outbound network traffic. Viewing bandwidth gauge activity
of end users helps target areas that are slowing down or
endangering the network.

There are two types of bandwidth gauges: bandwidth
gauges that monitor incoming/outgoing bandwidth for spec-
ified protocols (HTTP, FTP, SMTP, P2P, IM), each gauge
which is comprised of gauges that monitor incoming/
outgoing bandwidth for specified port numbers within that
protocol.

@ NOTE: Unlike URL dashboard gauges, protocol bandwidth

gauges cannot be added or removed from the interface.
However, protocol port numbers can be changed based on end
user utilization in your organization. (See Chapter 2, Edit Port
Settings for information on changing port numbers to be moni-
tored.)

Bandwidth Gauge Components

Incoming/outgoing bandwidth gauges include the following
gauges and ports (TCP and/or UDP) to monitor:

* HTTP - Hyper Text Transfer Protocol gauge monitors the
protocol used for transferring files via the World Wide
Web or an intranet.

This protocol gauge is comprised of gauges for moni-
toring the following ports by default:

* 80 - HTTP TCP port used for transferring and listening

* 443 - HTTPS TCP/UDP port used for encrypted trans-
mission over TLS/SSL
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» 8080 - HTTP Alternate (http-alt) TCP port used under
the following conditions: when running a second Web
server on the same machine (the other is using port
80), as a Web proxy and caching server, or when
running a Web server as a non-root user. This port is
used for Tomcat.

FTP - File Transfer Protocol gauge monitors the protocol
used for transferring files from one computer to another
on the Internet or an intranet.

This protocol gauge is comprised of gauges for moni-
toring the following ports by default:

* 20 - FTP TCP/UDP data port for file transfer

* 21 -FTP TCP/UDP control (command) port for file
transfer

SMTP - Simple Mail Transfer Protocol gauge monitors
the protocol used for transferring email messages from
one server to another.

This protocol gauge is comprised of gauges for moni-
toring the following ports by default:

* 25 - SMTP TCP/UDP port used for email routing
between mail server email messages

* 110 - POP3 (Post Office Protocol version 3) TCP port
used for sending/retrieving email messages

P2P - Peer-to-Peer gauge monitors the protocol used for
communication between computing devices—desktops,
servers, and other smart devices—that are linked directly
to each other.

This protocol gauge is comprised of gauges for moni-
toring the following ports by default:

* 1214 - TCP/UDP port for Kazaa, Morpheous, Grokster,
etc.

» 4662 - TCP/UDP port for eMule, eDonkey, etc.
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4665 - TCP/UDP port for eDonkey 2000

6346 - TCP/UDP port for Gnutella file sharing (Frost-
Wire, LimeWire, BearShare, etc.)

6347 - TCP/UDP port for Gnutella
6699 - UDP port for Napster
6881 - TCP/UDP port for BitTorrent

* IM - Instant Messaging gauge monitors the protocol used
for direct connections between workstations either locally
or across the Internet.

This protocol gauge is comprised of gauges for moni-
toring the following ports by default:

1863 - TCP/UDP port for MSN Messenger
5050 - TCP/UDP port for Yahoo! Messenger

5190 - TCP/UDP port for ICQ and AOL Instant
Messenger (AIM)

5222 - TCP/UDP port for Google Talk, XMPP/Jabber
client connection
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View Bandwidth Gauges

1. In the navigational panel, click Bandwidth to open its
menu.

2. Click either Inbound or Outbound to open the View
Incoming/Outgoing Bandwidth Gauge pop-up window:

View Incoming Bandwidth

..““*"“ [——) - - -

Fig. 4:1-1 View Incoming Bandwidth

The total score in bytes displays in each of the following
gauge icons: HTTP, FTP, SMTP, P2P, IM. The timespan
for gauge activity displays beneath each gauge icon.

3. Click the “X” in the upper right corner of the pop-up
window to close it.
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View bandwidth usage for a specified protocol

1. In the View Incoming/Outgoing Bandwidth gauge pop-up
window, right-click the bandwidth protocol gauge to open
its pop-up menu:

View Incoming Bandwidth
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Fig. 4:1-2 Bandwidth gauge pop-up menu

2. Select View Gauge Details to open the protocol gauge’s
pop-up window containing port gauges:
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Fig. 4:1-3 Protocol gauge pop-up window
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The total score in bytes displays in each of the porticons.
The total number of bytes for all ports in this window
equals the total number of bytes for the bandwidth
protocol.

TIP: The protocol gauge’s pop-up window is also accessible by
double-clicking the protocol gauge in the View Incoming/Outgoing
Bandwidth pop-up window.

View End User Bandwidth Gauge Activity

There are several ways to access information on end user
bandwidth gauge activity:

Overall end user bandwidth gauge activity - For a snap-
shot of all current bandwidth gauge activity ranked in
order by the highest to lowest end user score, use the
Overall Ranking option (see View Overall Ranking for
bandwidth). This option also lets you drill down and view
information on bandwidth gauges affected by a specified
end user.

End user activity by protocol gauge - For a snapshot of a
protocol gauge’s current activity ranked in order by the
highest to lowest end user score, use the Ranking Table
option (see View a protocol gauge ranking table).

End user activity by port gauge - For a snapshot of a port
gauge’s current activity ranked in order by the highest to
lowest end user score, use the port ranking table option
(see View a port gauge ranking table).
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View Overall Ranking for bandwidth

To view details about current bandwidth gauge activity for all
end users affecting bandwidth gauges:

1. In the Bandwidth section of the navigational panel, click
Overall Ranking to open the Overall Rankings pop-up

window:

Bandwidth Overall Rankings

Rankings by Owthound Traffic

P

*Scorein bytes (1024)

| score

200100101
200.100.10.2
200.100.10.2
200100106
200.100.10.4

4

Inbound

2155153
1881208
1580180
483025
an3

User Summary

Fig. 4:1-4 Bandwidth Overall Rankings

By default, this window includes rows of records for each
end user who is currently affecting one or more band-
width gauge for Outbound traffic. For each record in the
list, the following information displays: user IP address,
and corresponding Score in bytes. End users are ranked
in descending order by their byte score.

NOTE: To view current bandwidth gauge activity for incoming

traffic, click Inbound.

2. To drill down and view additional information about an
end user’s activity, click the IP address to highlight it.

3. Click User Summary to open the Individual User View
pop-up window (see Fig. 4:1-7), and perform any of the
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actions described for this window (see Monitor, Restrict
Bandwidth Usage).

4. Click the “X” in the upper right corner of this pop-up
window to close it.

View a protocol gauge ranking table

To view details about a specified bandwidth protocol
gauge’s current activity:

1. Right-click the bandwidth gauge to open its pop-up menu
(see Fig. 4:1-2).

2. Choose View Rankings to open the bandwidth protocol
gauge’s ranking table pop-up window:

Bandwidth Protocol Rankings: HTTP

Rankings by Incoming Traffic *Score in bytes (1024)
P

200100103
200.10010.1
2000100102

|Score
TE22478
7243383

4985863
200100106 71344

200100104 1248

4

Inbound Quthound User Summary

Fig. 4:1-5 Bandwidth Protocol Rankings

By default, this window includes rows of records for each
end user who is affecting this protocol gauge. For each
record in the list, the following information displays: user
IP address, and corresponding Score in bytes. End users
are ranked in descending order by their byte score.

TIP: To view current protocol gauge activity for outbound end
user traffic, click Outbound; for inbound traffic, click Inbound.
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NOTE: The protocol gauge’s ranking table pop-up window is also
accessible by right-clicking a protocol gauge, selecting View
Gauge Details from the pop-up menu (see Fig. 4:1-2), and then
clicking the Ranking Table button in the pop-up window.

3. To drill down and view additional information about an
end user’s activity, click the IP address to highlight it.

4. Click User Summary to open the Individual User View
pop-up window (see Fig. 4-1:7), and perform any of the
actions described for this window (see Monitor, Restrict
Bandwidth Usage).

5. Click the “X” in the upper right corner of this pop-up
window to close it.

View a port gauge ranking table

To view details about a specified port gauge’s current
activity:

1. Right-click the bandwidth gauge to open its pop-up menu
(see Fig. 4:1-2).

2. Select View Gauge Details to open the protocol gauge’s
pop-up window containing port gauges (see Fig. 4:1-3).

3. Click the port gauge to open its pop-up window:
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Bandwicdth Protocol Rankings: Port 80 x

Rankings by Inceming Traffic *Score in bytes (1024)

P | Score
200.10010.3 7481630
200100101 7122741
200100102 3948993
200100104 1248

4

Inhound Cutbound User Surmmary

Fig. 4:1-6 Port gauge ranking table

By default, this window includes rows of records for each
end user who is affecting this port gauge. For each
record in the list, the following information displays: user
IP address, and corresponding Score in bytes. End users
are ranked in descending order by their byte score.

TIP: To view current port gauge activity for outbound end user
traffic, click Outbound; for inbound traffic, click Inbound.

4.

To drill down and view additional information about an
end user’s activity, click the IP address to highlight it.

. Click User Summary to open the Individual User View

pop-up window (see Fig. 4-1:7), and perform any of the
actions described for this window (see Monitor, Restrict
Bandwidth Usage).

. Click the “X” in the upper right corner of this pop-up

window to close it.
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Monitor, Restrict Bandwidth Usage

The Individual User View window lets you view/restrict an
end user’s bandwidth usage.

1. From any of the user ranking windows, with the user-
name/IP address selected, click User Summary to open
the Individual User View pop-up window:

Individual User View

Threat Assessment Levels for User;
JThomas

IP: 200.100.10.1

Gauge Readings *Seorein bytes (1024)
Protocol ‘.In (hytes) | Out (bytes)

[ [ ]
P2P 1}
SMTP 1780 1240
FTF 1} 0

HTTF 6401543 2317242

IF: 200.100.10.1

Lockout

Port Wiew

Fig. 4:1-7 Individual User View

This window contains Gauge Readings for each band-
width gauge Protocol, with the end user’s corresponding
score in bytes for Inbound and Outbound bandwidth
traffic. The username/IP address displays in the Threat
Assessment Levels for User box, and the end user’s IP

address displays along with the Lockout and Category
View button.

TIP: To sort the list in descending order by either Protocol or
Inbound or Outbound score, click the column header. To sort the
list in ascending order, click the column header again.

2. After performing all intended actions in this window, click

the “X” in the upper right corner of the pop-up window to
close it.
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View the end user’s port usage in bytes

To monitor an end user’s bandwidth port traffic:

1. In the Individual User View pop-up window (see Fig. 4:1-
7), select the protocol gauge to highlight it.

2. Click Port View to open the View Details pop-up window:

View Details

Port

1863
050
5190
5222

|In (bytes) | Out (bytes
a 1]

a 1)

1687 470

a 1)

Fig. 4:1-8 View Details

This window contains Port numbers and the end user’s

corresponding score in bytes for Inbound and Outbound
bandwidth traffic.

. Click the “X” in the upper right corner of the window to
close it.
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Manually lock out an end user

To prevent the end user from accessing specified URLs that
result in too much bandwidth usage:

1. Click Lockout to open the Lockout dialog box (see Fig.
3:2-20).

2. Specify the Severity of the lockout from the choices in
the pull-down menu:

* Low - this selection lets you choose which library cate-
gory’s contents the end user will not be able to access

* Medium - this selection locks out the end user from
Internet access

* High - this selection locks out the end user from all
network access

3. Click No to close the dialog box, or click Yes to proceed.

+ If a “Low” severity was selected, clicking Yes opens
the Lockout by Categories pop-up window (see Fig.
3:2-21).

a. From the Available Categories list box, select the
available library category containing URLs the end
user should not access.

b. Click Add to move the library category to the
Assigned Categories list box.

TIP: To remove a library category from the Assigned Categories
list box, click the library category to highlight it, and then click
Remove to move the category back to the Available Categories
list box.

c. After adding all library categories, click Next to
open the alert box stating: “The user has been
locked out.”

d. Click the “X” in the upper right corner of the box to
close it.
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* If a “Medium” or “High” severity was selected:

a. Clicking Yes in the Lockout dialog box opens the
the alert box stating: “The user has been locked
out.”

b. Click the “X” in the upper right corner of the box to
close it.

NOTES: See End user workstation lockout in Chapter 2 of the
Configuration Section for information on what occurs on the end
user’s workstation when he/she is locked out.

The end user remains locked out of the specified areas on the
Internet/network until the administrator unlocks his/her worksta-
tion. To “unlock” the end user, go to the Lockout window in the
URL Dashboard section of the navigational panel. For information
on this feature, see Chapter 3: Alerts, Lockout Management in
the Configuration Section.
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Chapter 2: Modify Bandwidth Gauges

While bandwidth protocol gauges cannot be added or
removed, their timespan and threshold limits can be modi-
fied, along with their associated port numbers.

This function to modify bandwidth protocol gauges is avail-
able to a group administrator only if permissions were
granted by the administrator who set up his/her account, as
detailed in Chapters 2 and 3 of the Preliminary Setup
Section.

Modify Protocol Gauge Settings

1. To modify a bandwidth protocol gauge’s settings, click
Gauges in the Bandwidth section of the navigational
panel to open the Bandwidth Gauges pop-up window for
All Protocol Gauges:

Bandwidth Gauges

All Protocol Gauges

Protocol Timespan  Lower Limit Upper Limit

HTTP [15 | | [es53s |
Protocol Timespan  Lower Limit  Upper Limit
FTP [15 | o | [oooo ]
Protocol Timespan  Lower Limit Upper Limit
SMTP [15 | o | [ooso ]
Protocol Timespan  Lower Limit  Upper Limit
[ [15 | o | [ooco ]
Part Setup Save

Fig. 4:2-1 Bandwidth Gauges

This window includes the Timespan and threshold fields
for each Protocol gauge (HTTP, FTP, SMTP, P2P, IM).

2. Modify any of the following information:

* Timespan - the default is 15 minutes
» Lower Limit - the default lower threshold is “0” (zero)
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» Upper Limit - the default upper threshold for HTTP is
65535, and 20000 for all other protocols

3. If you do not need to modify any port settings, click Save
to save your edits and to close the Bandwidth Gauges
pop-up window.

Edit Port Settings

1. To change a protocol gauge’s port settings, in the Band-
width Gauges pop-up window (see Fig. 4:2-1), click Port
Setup to open the Port Setup pop-up window for Custom
Port Setup:

Port Setup

Custom Port Setup

Protocol Current Setting
HTTP

| [=
=
o

030

Protocol Current Setting
FTP 0

]

Save

Fig. 4:2-2 Port Setup

This window contains Current Setting fields for each
Protocol port.

2. To use a different port number than one currently
displayed in this window, enter a valid port number for the
Protocol.

3. Click Save to save your edits and to close the Port Setup
pop-up window.

4. Click Save to retain your settings and to close the Band-
width Gauges pop-up window.

100 8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE



BANDWIDTH MANAGEMENT SECTION CHAPTER 3: VIEW BANDWIDTH TREND REPORTS

Chapter 3: View Bandwidth Trend Reports

Similarly to URL trend reports, bandwidth trend reports help
you further configure bandwidth gauges and alerts so you
can focus on traffic areas that most affect the network.

There are two types of bandwidth trend reports that can be
generated on demand to show total gauge score averages
for a specified, limited time period: All Bandwidth Gauges
trend chart, and specified bandwidth protocol gauge trend
chart.

View All Bandwidth Gauge Activity

1. In the navigational panel, click Bandwidth to open that
menu.

2. Click Trend Chart to open the All Bandwidth Gauges
trend chart:

All Bandwidth Gauges

Enabled
Protocols

VIHTTP
VIFTP
VASHTP
= VIPIP
M

Timespan
One Hour

0.
1:30-2006 12:40:00 11-30-2006 13:10:00 1302005 13:40:00
All Visible Gauges

®pTTP ®FTP ®SMTP  p2p *IM

Fig. 4:3-1 All Bandwidth Gauges

By default, this chart contains the following information:
graphical depiction of last hour’s end user Score for all
bandwidth gauges (HTTP, FTP, SMTP, P2P, IM); fixed
time increments (using the MM-DD-YYYY HH:MM:SS
format); all Enabled Protocols selected; Timespan drop-
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down menu, and a color-coded key listing All Visible
Gauges.

3. After you have viewed the information in this chart, click

the “X” in the upper right corner of the window to close it.

View Activity for a Specified Gauge

1. In the Bandwidth section of the navigational panel,

choose either Inbound or Outbound to open the View
Incoming/Outgoing Bandwidth pop-up window (see Fig.
4:1-1).

. Double-click a bandwidth protocol gauge to open a pop-

up window displaying port gauges comprising that
protocol gauge (see Fig. 4:1-3).

. Click Trend Chart to open the Trend Chart for that

protocol gauge:

Trend Chart for HTTP
Bytes

12.
Enabled Port
Gauges
260 V80
) V443
) V15080

Timespan
One Hour

0.0
41-30-2008 12:20:00 11-30-2008 12:60.00 11-30-2008 13:20:00
HTTR

®Total #30 443 ®80&0

Fig. 4:3-2 Trend Chart for selected protocol gauge

By default, this chart contains the following information:
graphical depiction of last hour’s end user score in Bytes
for ports comprising that protocol gauge; fixed time incre-
ments (using the MM-DD-YYYY HH:MM:SS format); all
ports (Enabled Port Gauges) selected; Timespan drop-

8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE



BANDWIDTH MANAGEMENT SECTION CHAPTER 3: VIEW BANDWIDTH TREND REPORTS

down menu, and a color-coded key listing all ports for
that protocol gauge.

4. After you have viewed the information in this chart, click

the “X” in the upper right corner of the window to close it.

Suppress Criteria of Specified Ports

To view only specified port criteria in the chart, click the
checkbox corresponding to the port to suppress graphical
information for that port from displaying in the chart. To re-
enable displaying information for that port, click the
checkbox again.

View Criteria for a Different Time Period

To view a different time period of byte averages, make a
selection from the Timespan pull-down menu:

One Hour - this selection displays byte averages in 10
minute increments for the past 60-minute time period

Six Hours - this selection displays byte averages in 30
minute increments for the past six-hour time period

Twelve Hours - this selection displays byte averages in
one hour increments for the past 12-hour time period

One Day - this selection displays byte averages in one
hour increments for the past 24-hour time period

One Week - this selection displays byte averages in one-
day increments for the past seven-day time period

One Month - this selection displays byte averages in one-
day increments for the past month’s time period
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ADMINISTRATION SECTION

Introduction

The Administration Section of this user guide is comprised
of six chapters with instructions on maintaining the TAR
server or its database.

» Chapter 1: Custom Category Maintenance - This chapter
explains how the global administrator maintains criteria
for Custom Categories set up on the R3000 connected to
this TAR server.

* Chapter 2: View the Master User List - This chapter
explains the options for viewing end user information
comprising the Master User List.

» Chapter 3: View Administrator Activity - This chapter
explains how to use the Log Viewer to view activity
performed on TAR by the global or group administrators.

* Chapter 4: Maintain the Device Registry - This chapter
provides information to the global administrator on
viewing TAR’s registry of associated devices, synchro-
nizing TAR with the master R3000, adding another
R3000, and deleting a non-master R3000.

» Chapter 5: Perform Backup, Restoration - This chapter
explains how to perform a backup on the TAR server, and
how to restore user configuration settings saved in a
previous backup to the server.

» Chapter 6: Install Software Updates - This chapter
explains how the global administrator installs software
updates on the TAR server.

@ NOTE: As part of the maintenance procedures, the TAR server

will dispatch an email message to the global administrator—
whose email address was supplied during the quick start installa-
tion procedures—if there is any potential system error on TAR.
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Chapter 1: Custom Category Maintenance

From the TAR server, the global administrator can view
criteria for Custom Categories set up on the R3000
connected to this server. He/she can also add a custom
category to the R3000 using the Custom Categories window
on the TAR server.

1. In the navigational panel, go to URL Dashboard and click
Custom Categories to open the Custom Categories pop-
up window:

Custom Categories x

Custom Categories Category Name :
CarRating
Crossword Puzzles
Disting

Fantasy Sites
Science

-

Description :
_IURL

i [URL with wildcard
Update List _|Search Engine Keyword

e Save Delete Category

Fig. 5:1-1 Custom Categories

The descriptive name for each current custom category
displays in the Custom Categories frame.

@ TIP: Click Update List any time a custom library category has
been added, in order to force synchronization between the R3000
and the TAR unit.

2. After performing the intended actions in this window, click
the “X” in the upper right corner of the pop-up window to
close it.
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Add a Custom Category

1. Click New.

2. Enter up to seven characters for the Category Name.
This entry automatically displays in uppercase charac-
ters.

3. Enter the Description for the category.

4. Click in any of the checkboxes to display the corre-
sponding elements below:

* URL - clicking this checkbox displays the URL field,
and “URLs” tab below.

» URL with wildcard - clicking this checkbox displays the
URL with Wildcard (*) field, and “URLs with *” tab
below.

» Search Engine Keyword - clicking this checkbox
displays the Search Engine Keyword field, and
“Keywords” tab below.

5. Make the following entries, based on the checkbox selec-
tion(s):

* URL - type in the URL, and then click Add to include
the entry in the “URLs” tab.

@ TIP: If a protocol prefix is not entered, “http://” automatically will
precede the entry when Add is clicked and the entry is added to
the URLs list below.

* URL with Wildcard (*) - type in the wildcard after the
“*.” displayed in the text box, and then click Add to
include the entry in the “URLs with *” tab.

TIP: The minimum number of levels that can be entered is three
(e.g. *.yahoo.com) and the maximum number of levels is six (e.g.
*.mail.attachments.message.yahoo.com).

+ Search Engine Keyword - type in up to 64 alphanu-
meric characters, and then click Add to include the
entry in the “Keywords” tab.
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Custom Categories x

Custom Categories Category Name :

Car Racing e MANGA

Crogsword Puzles Description :

Dieting Manga

Fantasy Sites =

Science ~

ﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂ ¥ | MURL with wildcard

Update List MSearch Engine Keyword

URL :

httpieanstokyopap.corn Add
URLs : URLs with *: Keywords :

url

httpitenani manga.corm
hitpeibwsna. manganews. net
hittpyivesir directrnanga.carm

REY Save Delete Category

Fig. 5:1-2 New custom category

6. After making all entries, click Save to refresh the window
and to display the name of the newly added category in
the Custom Categories frame. The new category also is
added to the Custom Categories list on the R3000.

NOTE: The maximum number of Custom Categories that can be
added in the TAR interface is 131.

Delete a Custom Category

1. Click a Custom Category in the Custom Categories
window to highlight it, and to display information about
the category.

2. Click Delete Category to remove the category from the
Custom Category list. This action also removes the cate-
gory from the Custom Categories list on the R3000
connected to this TAR server.
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Chapter 2: View the Master User List

The Master User List contains end user IP addresses (and
usernames, if LDAP is used), along with corresponding
Personal User IDentification numbers (PUIDs) assigned to
end users by TAR. The Master User List is originally popu-
lated in TAR during the quick start installation process.

The View Master List window is used for verifying that the
list of active end users on the LDAP or IP group authentica-
tion server matches the list of end users on the R3000 and
TAR servers. If there are any discrepancies, a synchroniza-
tion can be forced between the three servers.

This function is available to a group administrator only if
permissions were granted by the administrator who set up
his/her account, as detailed in Chapters 2 and 3 of the
Preliminary Setup Section.

1. In the navigational panel, click Administration to open
that menu.

2. Click User Profiles to open the View Master User List
pop-up window:

View Master User List x

PUID |IP Display Name
202.208.207 ABest
202.202.20158 ARandall
202.202.2010 BFlores
202208208 BMarks
202.208.20.5 BSnetsinger
202.202.20.4 EThornas
202208206 CGJohnsan
202208208 GArmstrang
El 202.208.20.11 MSaunders
10 2022022012 TSmith

" 202208202 Zlamiesan
12 202.208.201 RReynolds
13 202.208.20.3 Shiontana =
.

L L I R

»
Search Options a»
PUID v Refresh

Search User Summary
Wildeard Character %

Fig. 5:2-1 View Master User List
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By default, this window is comprised of rows of end user
ID records, sorted in ascending order by PUID number.
For each PUID in the list, the following displays: corre-
sponding end user IP address, and Display Name (user-
name/IP address).

TIP: To sort the list in descending order by any column, click the
column header. To sort the list in ascending order, click the
column header again.

3. After performing the intended actions in this window, click
the “X” in the upper right corner of the pop-up window to
close it.

Search the MUL database

1. Make a selection from the Search Options pull-down
menu to specify the type of user search to perform:

* PUID - this selection performs a search by end user
Personal User IDs

* IP - this selection performs a search by end user IP
addresses

» Display Name - this selection performs a search by
end user usernames/IP addresses
TIP: To narrow your search criteria, make an entry in the wildcard
field by entering the beginning characters to be included in the
search, followed by the “%” (percent) character. For example, to
include only IP addresses beginning with 200, enter 200% in this
field.

2. Click Search to display records from the search that
match your criteria.
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View end user activity

1. To drill down and view additional information about an
end user’s activity, select the user’s record to highlight it.

2. Click User Summary to open the Individual User View
pop-up window (see Fig. 3:2-17), and perform any of the
actions described for this window (see Monitor, Restrict
End User Activity in the Configuration Section, Chapter
2: Custom Gauge Setup, Usage).

Synchronize TAR with the R3000, LDAP server

If changes were made to the user list on the LDAP server or
on the R3000, click Refresh to force a synchronization
between the servers. This action redisplays all current
records in the Master User List.
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Chapter 3: View Administrator Activity

The Log Viewer window is used for viewing the most recent
administrative activity performed on TAR by the global or
group administrators, for a period of time up to the past 30
days.

1. In the navigational panel, click Administration to open
that menu.

2. Click Log Viewer to open the Log Viewer pop-up window:

Log Viewer

Log Headings Results

I - | vintaeTiyve

Search by Admin Nam#:

Fig. 5:3-1 Log Viewer

3. After performing the intended actions in this window, click

the “X” in the upper right corner of the window to close it.

Perform a Search on a Specified Activity

To perform a search on a specified activity:

1. Select the type of activity from the Log Headings list: All,
Log In Attempt, Successful Log In, Add New Group, Add
New Administrator, Add Admin Detail, MUL Fetch, Edit
Group, Update Admin Info, Password Change, Delete
Admin, Delete Group.

2. In the Date Range field, click the E calendar icon on
the left to open the larger calendar for the current month,
with today’s date highlighted.
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TIP: To view the calendar for the previous month, click the left
arrow. To view the calendar for the next month, click the right
arrow.

3. Click the starting date to select it and to close the
calendar pop-up window. This action populates the field
to the left of the calendar icon with the selected date.

4. Click the = calendar icon on the right to open the larger
calendar for the current month, with today’s date high-
lighted.

5. Click the ending date to select it and to close the
calendar pop-up window. This action populates the field
to the left of the calendar icon with the selected date.

6. Click Search Dates to display the specified records for
the selected dates in the Results box.

TIP: To narrow your search criteria, make an entry in the Search
by Admin Name field, and click Search again.

Search Results

When populated with rows of records, the Results box
includes the following columns: AdminName (administrator
name from the Admin System window); activity Type (Log In
Attempt, Successful Log In, Add New Group, Add New
Administrator, Add Admin Detail, MUL Fetch, Edit Group,
Update Admin Info, Password Change, Delete Admin,
Delete Group); Target (administrator group hame or group
administrator name, if applicable), and Time [using the Mon
(abbreviated month name) DD, YYYY HH:MM:SS AM/PM
format].

TIP: To sort the list in descending order by another column, click
the column header. To sort the list in ascending order, click the
column header again.
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The information that displays in these columns differs
depending on the type of search performed, and if an
administrator name was specified in the Search by Admin
Name field.

The Target field displays information only as applicable for
any of the following actions executed by the administrator
(AdminName):

* Add New Group - the Target column for this selection
displays the administrator group name added in the
Group Management window

* Add New Administrator - the Target column for this selec-
tion displays the group administrator name added in the
Admin System window

* Add Admin Detail - the Target column for this selection
displays the group administrator name whose profile had
new information added in the Admin System window

+ Edit Group - the Target column for this selection this
selection displays the administrator group name whose
profile was modified in the Group Management window

* Update Admin Info - the Target column for this selection
displays the group administrator name whose profile was
updated in the Admin System window

» Password Change - the Target column for this selection
displays the group administrator name whose password
was modified in the Admin System window

* Delete Admin - the Target column for this selection
displays the name of the group administrator whose
profile was deleted from the Admin System window

» Delete Group - the Target column for this selection this
selection displays the administrator group name whose
profile was deleted in the Group Management window
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Chapter 4: Maintain the Device Registry

TAR’s device registry is used by the global administrator for
viewing a list of R3000-related devices connected to the
TAR unit, synchronizing TAR with the master R3000, adding
another R3000, and deleting a non-master R3000.

1. In the navigational panel, click Administration to open
that menu.

2. Click Device Registry to open the Device Registry pop-
up window:

Device Registry x

Current Devices

Active Directory [LGR3K200]
MTP Server [LGR3K200]
Patch Server [LGR3KZ00]
Proxy Server [LGR3K200]
LGR3K200

SMTP [LGR3K200]

Mew R3000 R3000 Synch

Delete Device View Device

Fig. 5:4-1 Device Registry

The default list of Current Devices includes the following
devices specified during the quick start procedure: Active
Directory server (if using LDAP), NTP Server, Patch
Server, Proxy Server, SMTP for email, master R3000
(displayed in a green bar), and any additional R3000
servers.

3. After performing the intended actions in this window, click
the “X” in the upper right corner of the window to close it.
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View device criteria

1. Click a device in the list to highlight it.

2. Click View Device to open the View Device pop-up
window:

View Device x

Mame: R3000212
Device Type R3000

I 20010010212

Fig. 5:4-2 View Device, R3000

The Name of the device from the Current Devices list
displays, along with the Device Type, and following infor-
mation for the type of device:

 Active Directory - Host name, IP address, Base (DC),
Port Number, User (Distinguished Name), Password

* NTP Server - NTP Server (IP address)

» Patch Server - User Name, Password

* Proxy Server - Proxy Switch (on, off), Proxy Server
(host name), User Name, Password

* R3000 - IP address

* SMTP - Server (host name), Port Number, User Name,
Password, Auth Mode, STMP Queue Size

3. Click the “X” in the upper right corner of the window to
close it.
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Synchronize TAR with the master R3000

A forced synchronization should be performed on the TAR
unit if any of the master R3000’s related devices listed in the
Device Registry are updated.

1. Click the master R3000 in the Current Devices list to
highlight that record.

2. Click R3000 Synch to synchronize TAR with all devices
associated with the master R3000.

Add, Delete a Non-Master R3000

Add an R3000 to the Device Registry

& WARNING: If adding another R3000, this additional R3000
should not be a master R3000 for any other TAR unit.

1. Click New R3000 to open the Add a New Device pop-up
window:

Add a Hew Device x

Mame:
Device Type: R3000

IP:

Al fields are required
Add Device

Fig. 5:4-3 Add a New Device

The Device Type “R3000” displays by default and cannot
be edited.
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2. Enter the Name of the R3000.
3. Enter the IP address of the R3000.

4. Click Add Device to close the pop-up window and to
display the Name of the R3000 in the Device Registry’s
Current Devices list.

Remove an R3000 from the Device Registry

1. Select the non-master R3000 from the Current Devices
list in the Device Registry pop-up window to highlight
your selection.

2. Click Delete Device to open the Delete Device dialog
box:

Delete Device x

R3000212

ArE you sure you want to delete this device?

Cancel Delete Device

Fig. 5:4-4 Delete Device

@ TIP: Click Cancel to close the dialog box and to return to the
Device Registry pop-up window.

3. Click Delete Device to close the dialog box, and to
remove the device name from the Current Devices list in
the Device Registry pop-up window.
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Chapter 5: Perform Backup, Restoration

This Backup/Restore window is used for backing up gauge
configuration settings to the TAR server, or restoring such
settings saved from a previous backup to the TAR server.

This function is available to a group administrator only if
permissions were granted by the administrator who set up
his/her account, as detailed in Chapters 2 and 3 of the
Preliminary Setup Section. Backup and restoration files
include settings pertinent to the administrator who config-
ured the gauges, and do not include other administrator’s
configuration settings.

By default, TAR performs an automatic backup each
morning at 2:00 a.m., storing up to seven days of automatic
backup files.

[‘% NOTE: In the event that TAR should fail, please contact 8e6
Technical Support to restore TAR with the most recent backup.

1. In the navigational panel, click Administration to open
that menu.

2. Click Backup/Restore to open the Backup And Restore
pop-up window:

Backup And Restore x
Backup user configuration

Backup on demand:

File Marme :

Backup Personal Data

Restore user configuration

Restore your settings to & previous
time by selecting & restoration file
Restoration File :

auto 1122 020001 2006
auto 1120 020001 2006
ht2 Hemrl 02306

auto 1123 020001 2006
antn 1424 NP00N0 2N0A

Restore Personal Setlings

Fig. 5:5-1 Backup And Restore
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The Restoration File box includes a list of up to seven of
the most recent automatic backup files, and any backup
files created on demand by the administrator.

Automatic backup files display in the following format:
auto date (in the MD format) time (in the HHMMSS
format) 2006. For example: auto 123 020001 2006
displays for an automatic backup executed on December
3, 2006 at 2:00:01 (2:00 a.m. and one second).

3. After performing the intended actions in this window, click
the “X” in the upper right corner of the window to close it.

Execute a Backup on Demand

On demand backups ensure user settings saved in these
files are retained on the server indefinitely.

1. In the Backup on demand section of the window, enter
the File Name for the backup file.

2. Click Backup Personal Data to back up current user
settings saved in the interface. Upon successfully
executing the file backup, the file name is added to the
Restoration File list, and a pop-up box opens displaying
the following message: “The operation was successful.”

3. Click the “X” in the upper right corner of the message box
to close it.
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Restore User Settings

1. From the Restoration File list, select the file to be
restored by clicking on it to highlight it.

2. Click Restore Personal Settings to restore user
settings from the selected file. Upon successfully
executing the file restoration, a pop-up box opens
displaying the following message: “The operation was
successful.”

3. Click the “X” in the upper right corner of the message box
to close it.
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Chapter 6: Install Software Updates

This chapter explains how the global administrator installs
software updates on the TAR server.

By default, the TAR server waits to receive software updates
each hour via Traveler, 8e6’s executable program. If a new
software update is available, it is downloaded to TAR and an
email message is dispatched to the global administrator

whose email address was supplied during the quick start

installation procedures. This email informs the administrator
of the software release version that is ready for installation.

If the global administrator does not manually apply this soft-
ware update to TAR, the update will be applied automati-
cally at midnight (12:00 a.m.).

Check for Available Software Updates

To check the console for available software updates:

1. In the navigational panel, click Administration to open
that menu.

2. Click Patch Install to open the Patch Install window:

Patch Install x
Install new patches
Click the Submit buttan to install this
patch. You'll be logged off
automatically, please alloww enough
time far the patch ta install
1.0.00.14
Submit
Current patch installed
0073
Restore previous patch
Click the Restore button 1o revert to
the previous patch. You'l be logged

oft automatically, please allow enough
time for the patch to install

Festore

Fig. 5:6-1 Patch Install
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This window displays any available software updates in
the Install new patches portion of the window. If no new
software updates are available, the following message
displays: “No new patches available”.

3. After performing the intended actions in this window, click
the “X” in the upper right corner of this window to close it.

Apply a Software Update

If a software update is available:

1. In the Install new patches section of the window, click
Submit to apply the software update.

2. Close the browser window, and wait five minutes for the
software update to be automatically applied to the server.

3. Launch a new browser window.
4. Clear the browser’s cache.

5. Log back in to TAR using the login window.

Revert to a Previous Software Installation

To restore the previous software version on the server:

1. Inthe Restore previous patch section of the window, click
Restore.

2. Close the browser window, and wait five minutes for the
previous software version to be automatically re-applied
to the server.

3. Launch a new browser window.
4. Clear the browser’s cache.

5. Log back in to TAR using the login window.
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TECHNICAL SUPPORT / PRODUCT
WARRANTIES

Technical Support

For technical support, visit 8¢6 Technologies’s Technical
Support Web page at http://www.8e6.com/support/
index.htm, or contact us by phone, by email, or in writing.

Hours

Regular office hours are from Monday through Friday, 8
a.m. to 5 p.m. PST.

After hours support is available for emergency issues only.
Requests for assistance are routed to a senior-level techni-
cian through our forwarding service.

Contact Information

Domestic (United States)

1. Call 1-888-786-7999
2. Select option 2

International

1. Call +1-714-282-6111
2. Select option 2

E-Mail

For non-emergency assistance, email us at
support@8e6technologies.com
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Office Locations and Phone Numbers

8e6 Corporate Headquarters (USA)

828 West Taft Avenue

Orange, CA 92865-4232

USA

Local 1 714.282.6111

Fax 1 714.282.6116

Domestic US : 1.888.786.7999

International o +1.714.282.6111
8e6 Taiwan

RM B2, 13F, No. 49, Sec. 3, Minsheng E. Rd.

Taipei 104

Taiwan, R.O.C.

Taipei Local : 2501-5285

Fax . 2501-5316

Domestic Taiwan : 02-2501-5285

International ;. 886-2-2501-5285
8e6 China

Beijing Room 909, 9 Floor

Tower 1, Bright China Chang An Building
No. 7, Jian Guo Men Nei Dajie

Beijing 100005, China

Beijing Local : 65180088

Fax . 65180328
Domestic China : 010-65180088
International . 86-10-65180088
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Support Procedures

When you contact our technical support department:

* You will be greeted by a technical professional who will
request the details of the problem and attempt to resolve
the issue directly.

» If your issue needs to be escalated, you will be given a
ticket number for reference, and a senior-level technician
will contact you to resolve the issue.

» If your issue requires immediate attention, such as your
network traffic being affected or all blocked sites being
passed, you will be contacted by a senior-level techni-
cian within one hour.

* Your trouble ticket will not be closed until your permission
is confirmed.
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Product Warranties

Standard Warranty

8e6 Technologies warrants the medium on which the 8e6
product is provided to be free from defects in material and
workmanship under normal use for period of one year (the
“Warranty Period”) from the date of delivery. 8e6 Technolo-
gies’ entire liability and customer’s exclusive remedy if the
medium is defective shall be the replacement of the hard-
ware equipment or software provided by 8e6 Technologies.

8e6 Technologies warrants that the 8e6 product(s) do(es)
not infringe on any third party copyrights or patents. This
warranty shall not apply to the extent that infringement is
based on any misuse or modification of the hardware equip-
ment or software provided. This warranty does not apply if
the infringement is based in whole or in part on the
customer’s modification of the hardware equipment or soft-
ware.

8e6 Technologies specifically disclaims all express warran-
ties except those made herein and all implied warranties;
including without limitation, the implied warranties of
merchantability and fitness for a particular purpose. Without
limitation, 8e6 Technologies specifically disclaims any
warranty related to the performance(s) of the 8e6
product(s). Warranty service will be performed during 8e6
Technologies’ regular business hours at 8e6 Technologies’
facility.
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Technical Support and Service

8e6 Technologies will provide initial installation support and
technical support for up to 90 days following installation. 8e6
Technologies provides after-hour emergency support to 8e6
server customers. An after hours technician can be reached
by voice line.

Technical support information:

Online: http://www.8e6.com/support/index.htm
Toll Free: 888-786-7999, press 2

Telephone: 1+714-282-6111, press 2

E-mail: support@8e6technologies.com

Have the following information ready before calling tech-
nical support:

Product Description:

Purchase Date:

Extended warranty purchased:
Plan #

Reseller or Distributor contact:

Customer contact:
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Extended Warranty (optional)

The extended warranty applies to hardware and software of
the product(s) except any misuse or modification of the
product(s), or product(s) located outside of the United
States. The extended warranty does not include new
product upgrades. Hardware parts will be furnished as
necessary to maintain the proper operational condition of
the product(s). If parts are discontinued from production
during the Warranty Period, immediate replacement
product(s) or hardware parts will be available for exchange
with defective parts from 8e6 Technologies’ local reseller or
distributor.

Extended Technical Support and Service

Extended technical support is available to customers under
a Technical Support Agreement. Contact 8e6 Technologies
during normal business hours, 8 a.m. to 5 p.m. PST, at (888)
786-7999, or if outside the United States, call 1+(714) 282-
6111.
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APPENDICES SECTION

Appendix A

Disable Pop-up Blocking Software

An administrator with pop-up blocking software installed on
his/her workstation will need to disable pop-up blocking in
order to use the TAR console.

This appendix provides instructions on how to disable pop-
up blocking software for the following products: Yahoo!
Toolbar, Google Toolbar, AdwareSafe, and Windows XP
Service Pack 2 (SP2).

Yahoo! Toolbar Pop-up Blocker

Add the Client to the White List

If the Client was previously blocked by the Yahoo! Toolbar, it
can be moved from the black list and added to the white list
so that it will always be allowed to pass. To do this:

1. Go to the Yahoo! Toolbar and click the pop-up icon to
open the pop-up menu:

) ¥ahaod Tonlhae: Nverdew - Micersalt Inteenet Buploees (=15
Fle  Cdt  view  Favorkes  Tooks  Help -
daback + = - (D[] A | Doearch [Ejrovokes Prede F | By S E - EH

subdiress [ 8] retp: jecitcompanion. yoho.comconhio) Sy RETINGEI R Sreme =] @o e

P - 2 l[searvt [-] e ) | Cinet - @y vaton T canms - 5 personsk - »
PogU Bocher -

YaEoO! Toolbar Pl Sound Whe Pog-Lp 12 Hoced Yahou! - Helg

Wiew Rincenty Binched Pop-Lins 3
alairs Allow Pop-Lpss From...
Tokal Pogr Lips Bincked: 3

Mext >

N Whry am 1 still getting pop-ups?
' Swarch Anedrs Tre I Mo
Overview i Yest ry.

More M.
Save time online with Yahoo! Toolbar __ Tel a Friend Abeut Pop-Lin Blocker

Fig. A-1 Select menu option Always Allow Pop-Ups From
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2. Choose Always Allow Pop-Ups From to open the Yahoo!
Pop-Up Blocker dialog box:

Yahoo! Pop-Up Blocker x|
Sources of Recently Blocked Pop-Ups:
=it companion.vahao.com Aoy I
Always Allow Pop-Ups From These Sources:
Geb.com Remove I
Help Close I

Fig. A-2 Allow pop-ups from source
3. Select the source from the Sources of Recently Blocked
Pop-Ups list box to activate the Allow button.

4. Click Allow to move the selected source to the Always
Allow Pop-Ups From These Sources list box.

5. Click Close to save your changes and to close the dialog
box.
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Google Toolbar Pop-up Blocker

Add the Client to the White List

8E6 TECHNOLOGIES,

To add the Client to the white list so that it will always be
allowed to pass, go to the Google Toolbar and click the #
blocked icon:

A Gcongle Toalhar Optians Help - Micrasolt Internet Fxplarer =100 %]
Pl ER Wew  Favortes  Took b -
ot Q) B Grortr i G 3| SW -1

¥ T S —————— ey ] | e ks

Coogle « w] fcamchwes +| g | (R Bhobleded | £ Fdosters &

[Chck: this bathon b ahwarys allow POGLS O 566, Com

GOUS[@ |'°‘°< el through, press the ‘i’ key whit cicing on a ik,

Toolbar

Clicking this icon toggles to the Site pop-ups allowed icon,
adding the Client to your white list:

Fig. A-3 # blocked icon enabled

2 Gonqle Toalhar (iptsans Help - Mirosolt Intemet Explarer =101 ]
Pl Ede Vew Favirkes  Took e n
ot Q) | Drortr it Gt | SW -
¥ T S —————— ey ] e
Google - =] sexchwet - | B | TR S popups skowed Y- oo 2
N—— -
[kuwr«m:or |
Google i
Toolbar

Fig. A-4 Site pop-ups allowed icon enabled
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AdwareSafe Pop-up Blocker

Disable Pop-up Blocking

AdwareSafe’s SearchSafe toolbar lets you toggle between
enabling pop-up blocking (# popups blocked) and disabling
pop-up blocking (Popup protection off) by clicking the pop-
up icon.

1. In the IE browser, go to the SearchSafe toolbar and click
the icon for # popups blocked to toggle to Popup protec-
tion off. This action turns off pop-up blocking.

2. After you are finished using the Client, go back to the
SearchSafe toolbar and click the icon for Popup protec-
tion off to toggle back to # popups blocked. This action
turns on pop-up blocking again.
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Windows XP SP2 Pop-up Blocker

This sub-section provides information on setting up pop-up

blocking and disabling pop-up blocking in Windows XP SP2.

Set up Pop-up Blocking

There are two ways to enable the pop-up blocking feature in
the IE browser.

Use the Internet Options dialog box

1. From the |IE browser, go to the toolbar and select Tools >
Internet Options to open the Internet Options dialog
box.

2. Click the Privacy tab:
Internet Options 1

General | Security| Privacy | Content | Connections || Programs | Advanced

Settings

P Move the slider to select a privacy setting for the Internet
=& zone.

HMedium

- Blocks thid-party cookies that do not have a compact

privacy policy

- Blocks third-party cookies that use personally identifiable
L information withaut your implicit consent

- Restricts first-party cookies that use perzonally identifiable

information withaut implicit consent

[ Sites... ][ Impart... ][Advancad..

Pop-up Blocker
Prevent most pop-up windows fram appearing.

Block pop-ups Settings.

[ oK ][ Cancel ][ Apply ]

Fig. A-6 Enable pop-up blocking

3. In the Pop-up Blocker frame, check “Block pop-ups”.
4. Click Apply and then click OK to close the dialog box.

8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE

133



APPENDICES SECTION APPENDIX A

134

Use the IE Toolbar

In the IE browser, go to the toolbar and select Tools > Pop-
up Blocker > Turn On Pop-up Blocker:

‘@ Microsoft Office Online: Installation Troubleshooter - Microsoft Internet Explorer

i Fle  Edt View Favorites

H e Bak v () |ﬂ

acdress | &] http: fofice. micrasa
Links @&]8e6 &) Source &

Tools  Help
Mail and Hews
Pop-up Blacker
Manage Add-ons
Synchronize...
Windows Update

3 »

W Tmonropupsocer  POSIS Gosewchies -

(&) 8e6 Channel Partners Newsletter & &) TurboPipe &) Be6 Website User Management

United States

Ol g i
L 10ffice Online

Windows Messenger
1€QLite
5un Java Consale

Internet Optians. .

Fig. A-6 Toolbar setup

e | Dowrleads ||

When you click Turn On Pop-up Blocker, this menu selec-
tion changes to Turn Off Pop-up Blocker and activates the
Pop-up Blocker Settings menu item.

You can toggle between the On and Off settings to enable or
disable pop-up blocking.
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Add the Client to the White List

There are two ways to disable pop-up blocking for the Client
and to add the Client to your white list.

Use the IE Toolbar

1. With pop-up blocking enabled, go to the toolbar and
select Tools > Pop-up Blocker > Pop-up Blocker

Settings to open the Pop-up Blocker Settings dialog box:

Pop-up Blocker Settings

Exceptions
Pop-ups are curently blocked. You can allow pop-ups from specific
‘Wb sites by adding the site to the list belaw.
Address of \weh site to allow:
|
Allowed sites
* Beb.com
Remove Al

Notifications and Filter Level

Play a sound when a pop-up is blocked.

Shaw Infarmation Bar when a pop-up is blocked.
Filter Level:

Medium: Black mast automatic pop-ups £V

Close

Pop-up Blocker FAD

Fig. A-7 Pop-up Blocker Settings

2. Enter the Address of Web site to allow, and click Add
to include this address in the Allowed sites list box. Click

Close to close the dialog box. The Client has now been
added to your white list.
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Use the Information Bar

With pop-up blocking enabled, the Information Bar can be
set up and used for viewing information about blocked pop-
ups or allowing pop-ups from a specified site.

Set up the Information Bar

1. Go to the toolbar and select Tools > Pop-up Blocker >
Pop-up Blocker Settings to open the Pop-up Blocker
Settings dialog box (see Fig. A-7).

2. In the Notifications and Filter Level frame, click the
checkbox for “Show Information Bar when a pop-up is
blocked.”

3. Click Close to close the dialog box.

Access the Client

1. Click the Information Bar for settings options:

3 Beb Technologies :: Internet Filtering and Reporting for the Enterprise - Microsoft Internet Explorer

Fie Edt Vew Favories Tooks Hel

Q- QM A G Pseos e @ -2 & - [ /B
ﬂn;?:,'.l.u.-z._.aeé.gm.'

F o | To 5ot
9 7opu bades. Tosee 1 p———— [

Always Aiow Pop-ups from This Site...

-1 Selite i | The Internet Filtering and Reparting Salution
Informati Ber Help | for the Enterprise.
B G Contact Us | 1.880.706.7999
i Home § Products i Solutions 3 Suppart i Press Genter - Partners 3 About 86 & Search

Fig. A-8 Information Bar menu options

2. Select Always Allow Pop-ups from This Site—this action
opens the Allow pop-ups from this site? dialog box:

Allow pop-ups from this site?

@ Would you bke to aliow pop-upa from ‘www Bal.com?

Fig. A-9 Allow pop-ups dialog box

136 8E6 TECHNOLOGIES, THREAT ANALYSIS REPORTER USER GUIDE



APPENDICES SECTION APPENDIX A

3. Click Yes to add the Client to your white list and to close
the dialog box.

NOTE: To view your white list, go to the Pop-up Blocker Settings
dialog box (see Fig. A-7) and see the entries in the Allowed sites
list box.
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Appendix B

System Tray Alerts: Setup, Usage

This appendix explains how to set up and use the feature for
System Tray alerts. A TAR Alert is triggered in a group
administrator’s System Tray if an end user’s Internet usage
has reached the upper threshold established for a gauge set
up by that group administrator.

This feature is only available if using LDAP authentication,
and is not available if using IP group authentication.

LDAP server configuration

Create the System Tray logon script

Before group administrators can use the TAR Alert feature,
an administrator with permissions on the LDAP server must
first create a logon script on the LDAP server for authenti-
cating group administrators.

1. From the taskbar of the LDAP server, go to: Start > Run
to open the Run dialog box:

Run [ 21 x]

- Type the name of & pragram, Folder, dacument, or
E Internet resource, and Windows will open it For yvou,

Open: I COWINDOWS sy svolldomainiscripts ;I

QK I Cancel | Browse. .. |

Fig. B-1 Run dialog box

2. In the Run dialog box, type in the path to the scripts
folder: C:\WINDOWS\sysvol\domain\scripts.

3. Click OK to open the scripts folder:
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[ C:\WINDOWS  sysvol| domain' scripts

Ele  EdR Wew Fyeodbes Toos  Hep
Bk - 3 -+ ¥ | semch Folders | (& 0 X 9 | [
Aakdress [ cowmD oW Slsysvelldomainlscriots

e »
Aevare [cors By »

Fig. B-2 C:\WINDOWS\sysvol\domain\scripts window

4. Right-click in this Windows folder to open the pop-up
menu.

5. Select New > Text Document to launch a New Text
Document:

[ Mew Tent Document tut - Motepad

He Edt Format Yew Help

[pecho of =]
start " T\\200.100.10. 21\win\tartrayw32, exe” ta[200.100.10.21]
L] _l—J

Fig. B-3 New Text Document
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6. Type the following text in the blank document file:
@echo off
start “” “\WX.X.X. X\win\tartrayw32.exe” ta[X.X.X.X]

in which “X.X.X.X” represents the IP address of the TAR
server, and “\win\tartrayw32.exe” refers to the location of
the TAR Alert executable file on the TAR server.

7. Go to: File > Save As to open the Save As window:

Savejn | () scipts EQ3 -

[5] New Text Document bt
| = tartray20.bat
| ltartray22. bat

Fie pyame: [tastrayz1 bat
Save as lype: |.°.l Files
Encodng Jansi

[E1QENNEY

!ﬁml
_ sl |

Fig. B-4 Save As dialog box

8. In the File name field, type in the name for the file using
the “filename.bat” format. For example: tartray21.bat.

NOTE: Be sure that the Save as type field has “All Files”
selected.

9. Click Save to save your file and to close the window.
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Assign System Tray logon script to administrators

With the “.bat” file created, the administrator with permis-
sions on the LDAP server can now begin to assign the
System Tray logon script to as many group administrators
as needed.

1. From the taskbar of the LDAP server, go to: Start >
Programs > Administrative Tools > Active Directory
Users and Computers to open the Active Directory
Users and Computers folder:

[fme 8@ B[54 et

Fig. B-5 Programs > Administrative Tools > Active Directory Users

2. In the Active Directory Users and Computers folder,
double-click the group administrator’'s Name in the Users
list to open the Properties dialog box for his/her profile:
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Fig. B-5 Properties dialog box, Active Directory Users folder

3. In the Properties dialog box, click the Profile tab to
display its contents.

4. In the Login script field, type in the “.bat” filename. For
example: tartray21.bat.

5. Click Apply to save your entry.
6. Click OK to close the dialog box.

7. Click the “X” in the upper right corner of the folder to
close the window.
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Group administrator usage of System Tray

Once the System Tray logon script has been added to a
group administrator’s profile, when the group administrator
logs on his/her workstation, the TAR Alert icon (pictured to
the far left in the image below) automatically loads in his/her
System Tray:

B EL- LYY B

NOTE: The TAR Alert icon will not load in the System Tray if the
TAR server is not actively running.

Use the TAR Alert icon’s menu

When right-clicking the TAR Alert icon, the following pop-up
menu items display:

» Tar Admin Interface - clicking this menu selection
launches a browser window containing the TAR Adminis-
trator Interface’s login window.

* Reconnect - clicking this menu selection re-establishes
the TAR Alert icon’s connection to the TAR server, reset-
ting the status of the TAR Alert icon to the standard
setting.

+ Exit - clicking this menu selection removes the TAR Alert
icon from the System Tray.
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Status of the TAR Alert icon

If there are no alerts for any gauges set up by the group
administrator, the following message displays when
mousing over the standard TAR Alert icon: “Connected. No
Alerts.”

However, if an alert is triggered, the TAR Alert icon changes
in appearance from the standard gauge to a yellow gauge
(pictured to the far left in the image below):

|« g W8 1:38PM

The following message appears briefly above the yellow
gauge: “New 8e6 TAR Alert!” The following message
displays whenever mousing over this icon: “New 8e6 TAR
Alert”.

If more than one alert is triggered for the group adminis-
trator, the message reads: “New 8e6 TAR Alert! (X Total)”, in
which “X” represents the total number of new alerts. The
following message displays whenever mousing over this
icon: “X New 8e6 TAR Alerts”, in which “X” represents the
total number of new alerts.
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View System Tray alert messages

1. Double-click the yellow TAR Alert icon to open the TAR
Alert box:

51

. |

Logon to TAR |
Fig. B-6 TAR Alert

This box contains the following message: “User (user-
name/IP address) has triggered the (Alert Name) alert
with a threshold of X (in which “X” represents the alert
threshold) on the (URL dashboard gauge name) gauge.’

The Logon to TAR button displays beneath this
message, followed by the Close button.

If more than one alert was triggered, the alert box

includes the following message and button to the right of
the Close button: “X more alerts” (in which “X” represents
the number of additional alerts), and the Next >> button.

2. Click Logon to TAR to launch the TAR login window (see
Fig. 1:1-1).

If there are additional alerts, click Next >> to view the
next TAR Alert. Each time the Next >> button is clicked,
the number of remaining alerts to be viewed decreases
by one. The Next >> button no longer displays after the
last alert is viewed.

3. Click Close to close the TAR Alert box.
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Appendix C

Glossary

This glossary includes definitions for terminology used in
this user guide.

base group - A user group consisting of end users whose
network activities are monitored by a designated group
administrator. This group cannot be modified, delegated to
another group administrator, or deleted.

custom category - A unique library category on the R3000
that includes URLs, URL keywords, and/or search engine
keywords to be blocked. In TAR, global administrators can
create and manage custom library categories and sync
them to the master R3000.

FTP - File Transfer Protocol is used for transferring files
from one computer to another on the Internet or an intranet.

global administrator - An authorized administrator of the
network who maintains all aspects of TAR. The global
administrator configures TAR, sets up user groups, adminis-
trator groups and group administrators, and performs
routine maintenance on the server.

group administrator - An authorized administrator of TAR
who maintains user group, administrator groups, group
administrator profiles, and gauges.

HTTP - Hyper Text Transfer Protocol is used for transferring
files via the World Wide Web or an intranet.

instant messaging - IM involves direct connections
between workstations either locally or across the Internet.

library category - A list of URLs, URL keywords, and
search engine keywords set up to be blocked.
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LDAP - One of two authentication method protocols that
can be used with TAR. Lightweight Directory Access
Protocol (LDAP) is a directory service protocol based on
entries (Distinguished Names). The other authentication
method that can be used with TAR is IP groups.

peer-to-peer - P2P involves communication between
computing devices—desktops, servers, and other smart
devices—that are linked directly to each other.

protocol - A type of format for transmitting data between
two devices. LDAP and SMB are types of authentication
method protocols.

Real Time Probe - On the R3000, this tool is used for moni-
toring the Internet activity of specified users in real time. The
report generated by the probe lets the administrator know
whether end users are using the Internet appropriately.

search engine - A program that searches Web pages for
specified keywords and returns a list of the pages or
services where the keywords were found.

SMTP - Simple Mail Transfer Protocol is used for transfer-
ring email messages between servers.

synchronization - A process by which two or more
machines run in parallel to each other. User filtering profiles
and library configurations can be set up to be synchronized
between TAR and the master R3000 server.

TCP - An abbreviation for Transmission Control Protocol,
one of the core protocols of the Internet protocol suite.
Using TCP, applications on networked hosts can create
connections to one another, over which streams of data can
be exchanged.

Traveler - 8e6’s executable program that downloads
updates to TAR at a scheduled time.
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UDP - An abbreviation for User Data Protocol, one of the
core protocols of the Internet protocol suite. Using UDP,
programs on networked computers can send short
messages (sometimes known as datagrams) to one
another.

URL - An abbreviation for Uniform Resource Locator, the
global address of Web pages and other resources on the
Internet. A URL is comprised of two parts. The first part of
the address specifies which protocol to use (such as "http").
The second part specifies the IP address or the domain
name where the resource is located (such as
“203.15.47.23” or "8e6.com").
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